[image: image1.png]The Meeting Transcript of
The Los Angeles County
Board of Supervisors




[image: image2.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors




August 19, 2008

[image: image3.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors





          Adobe Acrobat Reader 

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF document.  Acrobat Reader looks for the word by reading every word on every page in the file, including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:

            Choose Edit > Find Again 

            Reopen the find dialog box, and click Find Again. 
            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to
       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[The Board of Supervisors did not meet in

closed session Tuesday, August 19, 2008.]

SUP. BURKE, CHAIR: THE MEETING WILL PLEASE COME TO ORDER. THE INVOCATION WILL BE BY THE REVEREND GREG GARMAN, SENIOR PASTOR, NEWHALL CHURCH OF THE NAZARENE, FROM NEWHALL, FIFTH DISTRICT. THE PLEDGE WILL BE BY THE VETERANS' ADMINISTRATION -- MR. SMITH, JOE SMITH. 

REV. GREG GARMAN: WOULD YOU BOW YOUR HEADS WITH ME, PLEASE. OUR GRACIOUS AND MOST HOLY GOD, WE PAUSE AT THE BEGINNING OF THIS BEAUTIFUL AND NEW AWESOME SOUTHERN CALIFORNIA DAY TO GIVE YOU THANKS, FOR THIS IS THE DAY THAT GOD HAS MADE IT AND WE WILL REJOICE, WE ARE GLAD TO BE ALIVE IN IT. YOU ARE A HOLY GOD, A GOD OF REFUGE AND STRENGTH, AND A VERY PRESENT HELP IN THE TIME OF TROUBLE. WE WILL NOT FEAR EVEN THOUGH THE EARTH SHOULD CHANGE, AND THOUGH THE MOUNTAINS MIGHT SLIP INTO THE HEART OF THE SEA, THOUGH ITS WATERS ROAR AND FOAM, THOUGH THE MOUNTAINS QUAKE AT THE SWELLING PRIDE, YOU HAVE BROUGHT US THROUGH. SOME THROUGH FIRE AND SOME THROUGH THE FLOOD AND SOME THROUGH GREAT SORROW AND SOME EVEN AT THE END OF SHEDDING OF BLOOD. AND HOW THANK THANKFUL WE ARE, THOUGH, TO BE HERE AT THE BEGINNING OF THIS DAY TO GIVE YOU THANKS, TO ASK FOR YOUR HOLY PRESENCE AMONG THE DISCUSSION AND THE MEETINGS THAT WILL TAKE PLACE HERE. WE THANK YOU FOR OUR SUPERVISORS. WE THANK YOU FOR THE CHAIR. WE THANK YOU FOR THE STAFF AND FOR THE DEPARTMENT HEADS. AND THE AGENDA THAT WILL BE DISCUSSED THIS MORNING WE PRESENT TO YOU. OF COURSE, WE THANK YOU FOR THIS WONDERFUL COUNTY IN WHICH WE LIVE. WHAT A JOY TO LIVE IN PERHAPS ONE OF THE GREATEST, IF NOT THE GREATEST COUNTY IN THIS GREAT COUNTRY THAT WE LIVE. SO THANK YOU FOR THE PRIVILEGES THAT WE HAVE. WE COMMIT THIS MEETING, WE COMMIT THIS DAY INTO YOUR MIGHTY HANDS, KNOWING THAT YOU WILL GIVE GUIDANCE AND DIRECTION, WE PRAY IN YOUR NAME, AMEN. 

COL. JOSEPH SMITH: PLEASE PLACE YOUR RIGHT HAND OVER YOUR HEART AND JOIN ME IN THE PLEDGE OF ALLEGIANCE TO OUR FLAG. [PLEDGE OF ALLEGIANCE RECITED.] 

SUP. BURKE, CHAIR: SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: MADAME CHAIR, IT IS A PLEASURE TO INTRODUCE ONCE AGAIN PASTOR GREG GARMAN FROM THE SANTA CLARITA VALLEY. HE IS THE PASTOR OF THE CHURCH OF THE NAZARENE IN NEWHALL. PASTOR GARMAN HAS HAD A VERY EXCITING LIFE BECAUSE HE WAS RAISED ALONG THE AMAZON. HIS PARENTS WERE MISSIONARIES IN A SMALL TRIBAL COMMUNITY ALONG THE AMAZON RIVER OF PERU, IS WHERE HE WAS RAISED. HE'S A MARATHON RUNNER. HE'S RACED AROUND THE SOUTHERN WESTERN UNITED STATES. AND EVERY YEAR, HE LEADS A CONSTRUCTION CREW FROM HIS CHURCH TO THE AMAZON TO CONSTRUCT THE CHURCH BUILDINGS IN THE JUNGLE. SO HE'S MARRIED AND HAS TWO DAUGHTERS. AND WE APPRECIATE HIS EFFORTS IN CARRYING OUT THE GREAT COMMISSION. GOOD TO SEE YOU. [APPLAUSE.] 

SUP. BURKE, CHAIR: WE'LL NOW CALL THE AGENDA. 

CLERK SACHI HAMAI: GOOD MORNING, MADAME CHAIR, MEMBERS OF THE BOARD. WE WILL BEGIN TODAY'S AGENDA ON PAGE 4. AGENDA FOR THE MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION. ON ITEM 1-D, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THIS ITEM WILL BE CONSIDERED UNDER THE BOARD OF SUPERVISORS' REGULAR AGENDA AS ITEM 55 D. ON PAGE 5, AGENDA FOR THE MEETING OF THE HOUSING AUTHORITY, ITEMS 1-H THROUGH 3-H. 

SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: AGENDA FOR THE MEETING OF THE REGIONAL PARK AND OPEN SPACE DISTRICT, ITEM 1-P. 

SUP. BURKE, CHAIR: MOVED BY ANTONOVICH SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: BOARD OF SUPERVISORS, ITEMS 1 THROUGH 8. ON ITEM NO. 1, THERE IS A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. 

SUP. BURKE, CHAIR: WE'LL HOLD IT. 

CLERK SACHI HAMAI: THE REMAINING ITEMS ARE BEFORE YOU. 

SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY ANTONOVICH; WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: CONSENT CALENDAR, ON PAGE 9, ITEMS 9 THROUGH 52. ON ITEM NO. 9, WE WILL NEED TO HOLD THIS ITEM FOR FOUR VOTES. ON ITEM NO. 12, THERE IS A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 15, THERE IS A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 17, THERE IS A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 19, THE DIRECTOR OF D.H.S. REQUESTS -- EXCUSE ME -- THE DIRECTOR OF HEALTH SERVICES REQUESTS TO REVISE THE TERM OF THE AGREEMENT TO THE END OF AUGUST 31ST, 2012 INSTEAD OF AUGUST 31ST, 2014. DURING THIS FOUR-YEAR TERM, THE DEPARTMENT WILL CONDUCT AN R.F.P. TO SOLICIT NEW VENDORS. AND ALSO THERE IS A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 23, THERE IS A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 25, WE WILL NEED TO HOLD THIS ITEM, SINCE IT'S A FOUR-VOTE MATTER. ON ITEM NO. 27, WE WILL NEED TO HOLD THIS ITEM, SINCE IT'S A FOUR-VOTE MATTER. ON ITEM NO. 29 AND 30, WE WILL NEED TO HOLD BOTH OF THESE ITEMS SINCE THEY ARE FOUR-VOTE MATTERS. AND ALSO ITEM 31, WE WILL HOLD SINCE IT'S A FOUR-VOTE MATTER. ON ITEM NO. 36, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 37, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 44, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. AND THE REMAINING ITEMS ON THE CONSENT CALENDAR ARE BEFORE YOU. 

SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY ANTONOVICH; WITHOUT OBJECTION, SO ORDERED ON THE REMAINDER. 

CLERK SACHI HAMAI: ON PAGE 27, SEPARATE MATTERS, ITEM 53 AND I'LL READ THE SHORT TITLE IN FOR THE RECORD. THIS IS THE TREASURER AND TAX COLLECTOR'S RECOMMENDATION TO ADOPT RESOLUTION AUTHORIZING THE ISSUANCE AND SALE OF MONTEBELLO UNIFIED SCHOOL DISTRICT GENERAL OBLIGATION BONDS 2004 ELECTION SERIES, 2008 IN AGGREGATE PRINCIPAL AMOUNT NOT TO EXCEED $35 MILLION. 

SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY BURKE; WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: DISCUSSION ITEM, ITEM 54, WE WILL HOLD FOR A PUBLIC HEARING. MISCELLANEOUS ADDITIONS TO THE AGENDA WHICH WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING AS INDICATED ON THE SUPPLEMENTAL AGENDA. 55-A. 

SUP. BURKE, CHAIR: MOVED BY BURKE. SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: 55-B. 

SUP. BURKE, CHAIR: MOVED BY BURKE. SECONDED BY KNABE, WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: 55-C. 

SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY ANTONOVICH. WITHOUT OBJECTION SO ORDERED. 

CLERK SACHI HAMAI: 55-D. 

SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: ON 55-E, THE DIRECTOR OF HEALTH SERVICES REQUESTS THAT THE SETTLEMENT BE APPROVED TODAY BUT THE CORRECTIVE ACTION PLAN BE REFERRED BACK TO THE DEPARTMENT. 

SUP. BURKE, CHAIR: WITH THOSE PROVISOS, THAT CORRECTIVE ACTION BE REFERRED BACK, MOVED BY KNABE, SECOND BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS, SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT NO. 1. 

SUP. BURKE, CHAIR: SUPERVISOR MOLINA IS NOT HERE AT THIS TIME, SO I'LL GO FORWARD. I'D LIKE TO CALL UP CYNTHIA BANKS, DIRECTOR OF COMMUNITY SENIOR SERVICES. SISKESY ALLEN, CITY OF INGLEWOOD, LISA YARICK, M.S.W. OF KAISER PERMANENTE AND DIRECTOR OF LONG-TERM CARE AT WOODLAND HILLS MEDICAL CENTER. BONNIE HART, PRESIDENT OF FOOD AND NUTRITION MANAGEMENT SERVICES, AND SUE KENNEDY, WOULD YOU ALL PLEASE COME FORWARD? THEY'RE NOT HERE YET. OKAY. I'LL GO TO THE NEXT ONE. I'D LIKE TO CALL FORWARD THE 2008 NATIONAL ASSOCIATION OF AREA AGENCY AGING INNOVATION AWARD PARTICIPANTS, CYNTHIA BANKS, DIRECTOR. IS LAURA TREJO HERE? 

CYNTHIA BANKS: YES, SHE IS. 

SUP. BURKE, CHAIR: LAURA TREJO, GENERAL MANAGER OF THE CITY OF LOS ANGELES DEPARTMENT OF AGING. MANNY GUERRERO, PAST PRESIDENT OF LOS ANGELES COUNTY COMMISSION ON AGING. DR. JUDITH SATKIN, UNIVERSITY OF NORTHRIDGE, AND L.A. COUNTY COMMISSIONER ON AGING. COMMISSIONER MARILYN FREED, AMOS FREED, COMMISSIONER BERNARD WEINTRAUB AND COMMISSIONER NATALIE AMBROSE, WOULD YOU ALL PLEASE COME FORWARD? LOS ANGELES COMMUNITY AND SENIOR SERVICES AND LOS ANGELES CITY DEPARTMENT OF AGING HAVE BEEN HONORED WITH AN AGING INNOVATION AWARD BY THE NATIONAL ASSOCIATION OF AREA AGENCIES ON AGING FOR THEIR LOS ANGELES COUNTY SENIORS COUNT NEEDS ASSESSMENT. THE 2008 AGING INNOVATION AWARD RECOGNIZES AGING PROGRAMS FROM ACROSS THE COUNTRY THAT PROVIDE SUCCESSFUL, COST-EFFECTIVE APPROACHES THAT HELP OLDER ADULTS LIVE INDEPENDENTLY IN THEIR HOMES AND COMMUNITIES AND PROVIDE NEEDED SUPPORT TO CAREGIVERS OF OLDER ADULTS. THE L.A. COUNTY SENIOR COUNTS NEEDS ASSESSMENT COMMITTEE, WITH LEADERSHIP FROM THE LOS ANGELES COUNTY COMMISSION ON AGING CONDUCTED A LARGE-SCALE NEEDS ASSESSMENT OF OLDER ADULTS THROUGHOUT THE LOS ANGELES COUNTY REGION. OVER NEARLY A TWO-YEAR PROCESS, THE COMMITTEE DEVELOPED AND TESTED THE NEEDS ASSESSMENT SURVEY, DISTRIBUTED THE SURVEY IN ENGLISH AND SIX OTHER LANGUAGES, CREATED A WEB-BASED SURVEY AND USED SATELLITE MAPPING TO TRACK RESPONSES. IT IS WITH GREAT PLEASURE THAT I PRESENT THESE SCROLLS TO CYNTHIA BANKS, DIRECTOR OF THE LOS ANGELES COUNTY COMMUNITY AND SENIOR SERVICES, THE CITY OF LOS ANGELES DEPARTMENT OF AGING, AND ALL COLLABORATING COMMUNITY PARTNERS IN RECOGNITION OF YOUR SUCCESSFUL AGING PROGRAMS AND YOUR COMMITMENT. SO FIRST, I'M GOING TO CALL EACH PERSON UP. THE LOS ANGELES COUNTY COMMISSION ON AGING. COMMISSIONERS, PLEASE COME FORWARD. 

DR. JUDITH SATKIN: THE COMMISSION IS REALLY PLEASED TO BE ABLE TO ACCEPT THIS. I THINK IT'S ONE OF THE MOST IMPORTANT THINGS THAT WE'VE BEEN ABLE TO ACCOMPLISH OVER THE LAST SEVERAL YEARS. I LOOK FORWARD TO THE NEXT GENERATION AND MAYBE SOME IMPLEMENTATION DUE TO THE FINDINGS. THANK YOU. 

SUP. BURKE, CHAIR: TO THE LOS ANGELES CITY DEPARTMENT OF AGING. THANK YOU. WOULD YOU LIKE TO SAY A WORD? 

LAURA TREJO: BOARD MEMBERS, LAURA TREJO FROM THE CITY OF LOS ANGELES DEPARTMENT OF AGING. IT'S AN HONOR TO ONCE AGAIN BE BEFORE YOU ON A MAJOR COLLABORATIVE EFFORT BETWEEN BOTH AREA AGENCIES ON AGING. WE LOOK FORWARD TO MANY MORE OPPORTUNITIES TO COME BEFORE YOU WITH EQUAL LEVEL OF SUCCESS. THANK YOU. 

SUP. BURKE, CHAIR: THANK YOU. AND NOW WE'D LIKE TO CALL UP DR. JUDITH SATKIN. I'M SORRY. I'M COVERING YOUR FACE. [LAUGHTER.] THANK YOU. BERNARD WEINTRAUB. AMOS FREED. DORENE MOORE. MARILYN FREED. NATALIE AMBROSE. COMMUNITY SENIOR SERVICES. 

SPEAKER: THANK YOU SO MUCH. WE FEEL VERY HONORED TO RECEIVE THIS RECOGNITION. IT HAS BEEN A THREE-YEAR PROJECT INVOLVING VOLUNTEERS, STAFF IN THE COUNTY, STAFF IN THE CITY, AND ALL THOSE DEPARTMENTS, MANY DEPARTMENTS IN THE CITY AND COUNTY THAT WORK TOGETHER TO MAKE THIS HAPPEN. AND I THINK IT'S VERY REWARDING THAT WE'RE GOING TO BE ABLE TO -- NOW THAT WE'VE ASSESSED THE NEEDS OF SENIORS HOPEFULLY TO SEE THAT THOSE NEEDS ARE MET. THANK YOU. 

CYNTHIS BANKS: THANK YOU, SUPERVISOR BURKE AND ALL OF THE SUPERVISORS. WE REALLY APPRECIATE THIS HONOR. AS EVERYONE HAS SAID, THIS HAS BEEN A TWO TO THREE-YEAR EFFORT. BUT OUR PRIMARY FOCUS IS AND ALWAYS HAS BEEN THE SENIORS WITHIN LOS ANGELES COUNTY. WITH THIS REPORT AND THE FINDINGS, WE HOPE TO BE ABLE TO PROVIDE FOR THE NEEDS OF THE SENIORS NOT ONLY NOW BUT IN THE FUTURE. 

SUP. BURKE, CHAIR: THANK YOU VERY MUCH. SUPERVISOR MOLINA, BEFORE I CALL ON YOU, SHOULD I CALL THOSE ITEMS FOR FOUR VOTES ON THE AGENDA THAT WE PUT OVER? WE HELD ITEM 25. MOVED BY MOLINA, SECONDED BY KNABE, WITHOUT OBJECTION, SO ORDERED. ITEM 27, MOVED BY ANTONOVICH, SECONDED BY MOLINA; WITHOUT OBJECTION, SO ORDERED. ITEM NO. 29, MOVED BY KNABE, SECONDED BY MOLINA; WITHOUT OBJECTION, SO ORDERED. ITEM 30, MOVED BY ANTONOVICH, SECONDED BY MOLINA; WITHOUT OBJECTION, SO ORDERED. ITEM 31, MOVED BY KNABE, SECONDED BY MOLINA; WITHOUT OBJECTION, SO ORDERED. AND SO THOSE ITEMS, THEY WERE FOUR-VOTE ITEMS THAT WE PUT OVER. SUPERVISOR MOLINA. 

SUP. MOLINA: I'M GOING TO ASK SHERIFF LEE BACA TO COME UP AND JOIN ME FOR THIS PRESENTATION AND DEPUTY ROSE? AND DEPUTY ARCHAMBAULT. WELL, IT'S MY HONOR THIS MORNING ALONG WITH LEE BACA TO MAKE A VERY SPECIAL PRESENTATION. WE ARE HONORING TWO EXEMPLARY SHERIFF'S DEPUTIES IN RECOGNITION OF THEIR COMPASSIONATE EFFORTS TO SERVE HOMELESS INDIVIDUALS AND FAMILIES IN THE CITY OF INDUSTRY AREA. SINCE 2006, THESE OUTSTANDING PUBLIC SERVANTS HAVE REACHED OUT TO THE HOMELESS THROUGHOUT VARIOUS PARTS OF SAN GABRIEL VALLEY ENCAMPMENTS. THE DEPUTIES WORK CLOSELY WITH MY STAFF AND LOCAL AGENCIES TO MOBILIZE VITAL RESOURCES TO THESE HOMELESS INDIVIDUALS AND FAMILIES, AND TO HELP THEM MEET THE MANY CHALLENGES AND TO BEGIN NEW LIVES. IN FACT, THE DEPUTIES' GREAT SUCCESS HAS INSPIRED OTHER JURISDICTIONS TO ESTABLISH VERY SIMILAR EFFORTS. THESE DEPUTIES HAVE TRULY GONE ABOVE AND BEYOND THE CALL OF DUTY TO MEET THE NEEDS OF THE HOMELESS. DEPUTY ROSE, AS WELL AS DEPUTY ARCHAMBAULT, HAVE EARNED THE DEEP RESPECT, NOT ONLY OF ALL OF MY FIRST DISTRICT STAFF, BUT NUMEROUS COUNTY DEPARTMENTS AS WELL AS A MULTITUDE OF LOCAL SERVICE AGENCIES. THEIR ENERGY, THEIR OPTIMISM, AND THEIR TIRELESS EFFORTS TO AID THE MOST VULNERABLE RESIDENTS IN OUR OWN COMMUNITY IS TRULY ADMIRABLE. ALSO, OF COURSE WE WANT TO ACKNOWLEDGE DEPUTY ROSE'S FINE SERVICE TO OUR NATION, HE WILL SOON BE DEPLOYED TO AFGHANISTAN IN SEPTEMBER. LET'S ALL JOIN IN WELCOMING AND MORE IMPORTANTLY GIVING HIM THANKS. DEPUTY ROSE? THANK YOU SO MUCH. IS THIS YOUR FAMILY THAT YOU BROUGHT? [APPLAUSE.] 

DEPUTY JOHN ROSE: YES, MA'AM. 

SUP. MOLINA: LET ME INTRODUCE YOU HERE. COME ON UP. LET ME PRESENT THIS TO YOU. HE HAS BROUGHT HIS ENTIRE FAMILY FROM INDIANA? 

DEPUTY JOHN ROSE: MY MOM'S FROM INDIANA. 

SUP. MOLINA: PLEASE SHARE A FEW WORDS, IF YOU WOULD. 

DEPUTY JOHN ROSE: THANK YOU VERY MUCH FOR THIS HONOR. ON BEHALF OF MYSELF AND THE SHERIFF'S DEPARTMENT, COPS BUREAU, THIS IS MY MOM. SHE'S FROM INDIANA, SO I'M VERY GRATEFUL TO HAVE HER HERE TODAY. SO THANK YOU VERY MUCH. 

SUP. MOLINA: CONGRATULATIONS. LET ME PRESENT THE OTHER ONE FIRST. AND OF COURSE JOINING HIM IN THIS EFFORT IS DEPUTY PAUL ARCHAMBAULT. CONGRATULATIONS, SIR. AND THANK YOU SO MUCH FOR ALL OF YOUR WORK. GREAT JOB. [APPLAUSE.] I'M GOING TO ASK LEE BACA TO COME UP AND SHARE A FEW WORDS. HE'S AS PROUD OF HIS DEPUTIES AS I AM. 

SHERIFF LEE BACA: THANK YOU, SUPERVISOR MOLINA. LADIES AND GENTLEMEN, LET ME JUST TELL YOU EXACTLY WHAT THESE TWO MEN DID, ALONG WITH A BIGGER TEAM OF THE COUNTY RESOURCES AND NONPROFITS. PEOPLE WERE LIVING UNDERNEATH THE BRIDGE, ABOUT 60 OR 70 PEOPLE HAD BEEN THERE FOR YEARS. NO OTHER PLACE TO GO. NO OTHER PLACE TO LIVE. THE SHERIFF'S DEPARTMENT DOES NOT DO SWEEPS. PEOPLE WHO ARE HOMELESS, IF THEY COMMIT A CRIME, OBVIOUSLY THEY'LL GO TO JAIL FOR THE CRIME. BUT THESE PEOPLE WERE IN A VERY DESPERATE PLACE. THESE DEPUTIES INTERVIEWED EACH ONE OF THESE INDIVIDUALS, ASKED THEM IF WE CAN FIND YOU A NEW HOME, WITH THE RIGHT SERVICES, WOULD YOU BE WILLING TO MOVE? WOULD YOU WILLINGLY MOVE TO A NICER PLACE? SO THEY GOT HOLD OF ALL THE SERVICE AGENCIES AND EACH ONE OF THE INDIVIDUALS HAD A PLACE TO GO TO. SO WHEN MOVING DAY CAME, THERE WASN'T ANY BATONS. THERE WASN'T ANY LAW ENFORCEMENT. IT WAS A COOPERATIVE MOVE. AND INDIVIDUAL VANS AND INDIVIDUAL HEALTHCARE CAME AND PEOPLE PACKED UP WHAT THEY WANTED TO TAKE. AND OFF THEY WENT TO NEW HOMES. THIS IS WHAT THE COUNTY OF LOS ANGELES DOES. AND SUPERVISOR MOLINA, YOU AND YOUR BOARD MEMBERS HAVE BEEN VERY PROACTIVE IN TRYING TO DO THE RIGHT THING WITH HOMELESS. I THINK THAT'S WHY THESE TWO GENTLEMEN HERE ARE NOT ONLY HEROES TO OUR COUNTY BUT THEY'RE HEROES TO THE HOMELESS AND THEY SHOW HOW IT CAN BE DONE THROUGHOUT AMERICA. THANK YOU VERY MUCH. [APPLAUSE.] 

SUP. MOLINA: I'M GOING TO ASK STEVE COOLEY TO COME UP AND JOIN ME AS WELL AS HIS DEPUTY. JOHN? HOW ARE YOU? OH, GOOD, COME ON UP. WE ARE HERE, FIRST OF ALL, TO PAY TRIBUTE FOR OUTSTANDING WORK THAT HAS BEEN DONE. BUT MORE IMPORTANTLY TO ALSO ANNOUNCE THAT WE HAVE RECENTLY WON THE NATIONAL ACHIEVEMENT AWARD FROM NACO, WHICH IS A NATIONAL ASSOCIATION OF COUNTIES, FOR THE EAST LOS ANGELES PARENT PROJECT COLLABORATIVE UNDER NACO'S CRIMINAL JUSTICE AND PUBLIC SAFETY CATEGORY. LET ME SHARE WITH YOU WHAT SOME OF THE GREAT WORK THAT THEY'VE DONE. MY OFFICE HAS FUNDED A PROGRAM WITHIN THE D.A.'S OFFICE KNOWN AS STRATEGIES AGAINST GANG EMPOWERMENT KNOWN, AS SAGE. IT'S A PROSECUTOR IN EAST LOS ANGELES WHO PROACTIVELY WORKS WITH LOCAL OFFICIALS, BUSINESSES AND OTHERS TO DEVELOP AND IMPLEMENT EFFECTIVE CRIME PREVENTION AND INTERVENTION STRATEGIES. THIS COORDINATED APPROACH GIVES PARENTS THE TOOLS TO REGAIN CONTROL OF THEIR TEENAGERS WHO ARE INVOLVED IN CRIMINAL BEHAVIOR SUCH AS TRUANCY, GRAFFITI, GANG ASSOCIATION, ALCOHOL AND DRUG ABUSE, AS WELL. SHORTLY AFTER ARRIVING IN EAST LOS ANGELES THREE YEARS AGO, DEPUTY DISTRICT ATTORNEY JOHN CARLOS SOFOLINO ENLISTED PARTNERS FROM OUR PARKS DEPARTMENT, PROBATION STATION, BOYS AND GIRLS' CLUB OF EAST L.A., MY STAFF AND OTHERS TO CARRY OUT THIS MISSION. WHILE THE PROGRAM BEGAN AT THE EAST L.A. SHERIFF'S PATROL DEPUTIES WERE INSTRUMENTAL IN RECRUITING AND REFERRING VARIOUS PARENTS TO THE PROJECT CURRICULUM. THEY PROVIDED FLYERS TO THE PARENTS WHO FACE CHALLENGES WITH THEIR OWN CHILDREN. THE COLLABORATIVE'S INTENSIVE, INTERACTIVE, HANDS-ON COURSE TEACHES PARENTS TO WORK TOGETHER IN GROUPS TO PROVIDE EACH OTHER EMOTIONAL SUPPORT NEEDED TO DEAL WITH THEIR CHILDREN WHO MANY TIMES ARE OUT OF CONTROL. SINCE THE FALL OF 2005, THE EAST LOS ANGELES COLLABORATIVE CLASSES IN ENGLISH AND SPANISH, THEY ARE BOTH IN THE MORNINGS AND IN THE EVENINGS, HAVE BEEN OFFERED TO THESE VARIOUS CONVENIENT LOCATIONS. THIS SUMMER, OVER 105 PARENTS ARE ATTENDING CLASSES, AND ADDITIONAL PARENTS HAVE REGISTERED FOR THE PROGRAM THIS COMING SEPTEMBER. I'M PROUD TO SHARE WITH YOU THAT OVER 738 PARENTS HAVE GRADUATED FROM THIS PROGRAM SO FAR. I'VE HAD AN OPPORTUNITY TO ATTEND THEIR GRADUATION. AND I'M SO VERY IMPRESSED WITH THE OUTCOMES. THE PARENTS ARE PROUD NOT ONLY OF GRADUATING BUT THEY'RE ALSO VERY PROUD OF HAVING PARTICIPATED AND REALLY LEARNED SOME SKILLS TO HELP THEM WITH THEIR CHILDREN. WE ARE NOW VERY PROUD THAT THE EAST LOS ANGELES PARENT PROJECT COLLABORATIVE IS NOW SUCCESSFUL AND RECOGNIZED AS A COMMUNITY PROGRAM IN THE EAST SIDE, PROVIDES EDUCATION, TRAINING AND SUPPORT TO PARENTS. NACO WAS VERY PROUD. I'M SURE AS WE ARE IN PRESENTING US THIS AWARD. SO TODAY, I AM JOINED BY THE EAST LOS ANGELES PARENT PROJECT COLLABORATIVE, ALL THE PEOPLE THAT ARE HERE, INVOLVES A WHOLE NUMBER OF PEOPLE, DISTRICT ATTORNEY STEVE COOLEY, AS WELL AS THE DEPUTY DISTRICT ATTORNEY JOHN TUSCALINO, WHO HAS REALLY SPEARHEADED THIS RAN WITHOUT HIS LEADERSHIP WE WOULDN'T HAVE HAD THE OPPORTUNITY TO HAVE THE TREMENDOUS SUCCESS THAT WE HAVE. SO I WANTED TO MAKE A PRESENTATION TO ALL OF THEM. JOHN, STEVE, CONGRATULATIONS TO ALL OF YOU. AND THIS IS THE WHOLE COLLABORATIVE. WE'RE ALL VERY PROUD OF THEM. CONGRATULATIONS, GENTLEMEN. [APPLAUSE.] 

STEVE COOLEY, D.A.: WELL THANK YOU, SUPERVISOR, THIS IS INDEED A GREAT HONOR. THIS RECOGNITION AT THE NATIONAL LEVEL FOR THIS PROGRAM SHOULD GIVE US SOME PAUSE TO THINK ABOUT TAKING THIS VERY SUCCESSFUL PROGRAM COUNTY WIDE. THIS NEED TO INTERVENE AND PREVENT ACTIVITY AMONG OUR YOUNG PEOPLE, DRINKING, JUVENILE CRIME, GANG ACTIVITY, ETC., IS A COUNTY-WIDE ISSUE. I THINK WHAT WE'VE IDENTIFIED HERE IS THE FACT THAT PERHAPS OUR BEST ALLIES IN THIS EFFORT TO KEEP YOUNG PEOPLE AWAY FROM TROUBLE, OUT OF TROUBLE, MAY VERY WELL BE THEIR PARENTS. TO GET THEM MORE INVOLVED, MORE AGGRESSIVELY INVOLVED, GIVE THEM THE SKILLS, TO BRING THEIR YOUNG PEOPLE ALONG IN A POSITIVE WAY THAT MIGHT BE REAL KEY TO SOME FUTURE SUCCESS. DEPUTY JOHN TOSELLO WAS A LEAD IN THIS. ALTHOUGH I THINK IT GOES WITHOUT SAYING THAT WITHOUT SUPERVISOR MOLINA'S SUPPORT, THIS PROGRAM WOULD HAVE NEVER GOTTEN OFF THE GROUND, WOULD HAVE NEVER PULLED TOGETHER THESE PARTNERS, AND WOULD HAVE NEVER ACHIEVED THIS GREAT AWARD. SO, JOHN? 

JOHN TOSELLO: THE MOST REMARKABLE THING ABOUT THIS PROGRAM IS THAT PARENTS LEARN HOW TO TRUST LAW ENFORCEMENT, JUDGES, THE JUDICIAL SYSTEM, PROBATION OFFICERS. AND ONCE THEY LEARN HOW TO TRUST OFFICERS, JUDGES, THEY SEE THEM AS PARTNERS TO REFORM THEIR KIDS, GET THEIR KIDS BACK IN SCHOOL AND GET THEIR KIDS BACK ON THE STRAIGHT AND NARROW SO THEY CAN LEAD GREAT AND PRODUCTIVE LIVES. 

SUP. MOLINA: MR. COOLEY, I JUST WANT YOU TO KNOW HOW OFTEN I GET COMPLIMENTS ABOUT JOHN AND HIS LEADERSHIP IN THIS PROGRAM. YOU SHOULD BE VERY PROUD OF HIS EFFORT, IT'S TREMENDOUS AND IT'S WORTH ACKNOWLEDGING. I WANTED TO ASK LEE BACA TO JOIN US AND SHARE A FEW WORDS. HIS DEPUTIES ON THE EAST SIDE HAVE BEEN TREMENDOUS IN PROVIDING THE REFERRALS AND LETTING US KNOW. IT'S A WONDERFUL INTERVENTION PROGRAM STARTING DIRECTLY WITH THE PARENTS. SHERRIFF? 

SHERIFF LEE BACA: THANK YOU, SUPERVISOR. ECHOING WHAT'S BEEN SAID BY MR. COOLEY AND OUR GREAT DEPUTY D.A. HERE, I THINK THAT ALL OF US KNOW ONE THING. AND THAT IS, OUR PARENTS ARE THE KEY TO OUR LIFE. AND WHEN WE SEE PARENTS STRUGGLING, NOT BECAUSE THEY DON'T HAVE THE PROPER IDEAS ABOUT PARENTING, BUT WHEN THEY STRUGGLE BECAUSE OF THE CONDITIONS, WHETHER THEIR CHILDREN ARE AFFECTED BY TOUGH NEIGHBORHOODS OR AFFECTED BY SCHOOL DIFFICULTIES, THE TRUTH OF THE MATTER IS, THE PARENT OFTEN WONDERS WHAT MORE CAN I DO? AND WHEN YOU HAVE A SUPERVISOR AND A D.A. AND OF COURSE THE SHERIFF'S DEPARTMENT, AS WELL, THAT CARES ABOUT PARENTS, THEN WE'LL DO SOMETHING THAT'S WELL BEYOND THE NORM. AND EVERYONE HERE, THE EAST LOS ANGELES SHERIFF'S STATION WAS VERY INVOLVED IN THIS. AND I THINK THE MODEL THAT SUPERVISOR MOLINA ALLUDES TO IS CLEARLY IN FRONT OF US. THAT UNLESS WE HELP OUR PARENTS BE STRONGER, THEN ULTIMATELY WE'LL TAKE OVER IN A WAY THAT WOULDN'T BE POSITIVE FOR ANYBODY. AND CRIME IN AND OF ITSELF IS NO ANSWER FOR GOOD PARENTING. AND SO THE PARENTS, THANK THEM. THEY ARE THE TRUE PEOPLE WHO STEPPED UP AND SAID "I WILL COME AND I WILL LEARN AND I WILL TRUST." AND I THANK YOU, SUPERVISOR MOLINA, AND MY GOOD FRIEND MR. COOLEY, AND PARTICULARLY THE PEOPLE STANDING BEHIND US BECAUSE THEY'RE THE ONES THAT REALLY DID THE WORK. SO THANK YOU VERY MUCH. [APPLAUSE.] 

SUP. MOLINA: LET ME JUST FINALLY SHARE, THIS AWARD IS A TREMENDOUS HONOR. THIS COLLABORATION HAS BEEN OPERATING FOR A WHILE. IT'S GETTING BETTER AND BETTER ALL OF THE TIME. WE HAVE JOINING US AS WELL BOB TAYLOR FROM PROBATION DEPARTMENT, THEY'RE INSTRUMENTAL, THEY'RE A VERY EFFECTIVE PARTNER. WE HAVE OUR CAPTAIN, HENRY ROMERO, FROM THE EAST L.A. SHERIFF'S STATION ALSO IS A DEPUTY THERE. AND OF COURSE, WE ALSO HAVE OUR PARK STAFF WHO HAVE BEEN A PART OF IT, HEADED UP BY OUR DEPARTMENT HEAD, AS WELL. THIS IS A COLLABORATIVE EFFORT. IT INVOLVES VARIOUS OTHER COUNTY DEPARTMENTS, AS WELL. WE ALL WORK TOGETHER. ALL OF US TRYING TO FIND A WAY. EACH OF US AS PARENTS KNOW THE CHALLENGES THAT WE HAVE. BUT WHEN OUR CHILDREN TAKE THE WRONG PATH, IT'S TOUGHER EVERY SINGLE DAY. BUT HERE THEY KNOW ON THE EAST SIDE THAT IF THEY WANT A HELPING HAND, IT IS AVAILABLE TO THEM. SO WE WANT TO ACKNOWLEDGE AND THANK NACO FOR THE AWARD. I WANT TO THANK ALL OF THESE INDIVIDUALS. THEY HAVE MADE US ALL VERY, VERY PROUD. THANK YOU SO VERY MUCH. AND WE ALSO HAVE ONE OF THE PARENTS. MR. LOPEZ. THANK YOU. WE ALSO HAVE ONE OF THE PARENTS THAT HAVE JOINED AS ONE OF THE 738 THAT HAVE GRADUATED SO FAR FROM THIS PROGRAM. CONGRATULATIONS, SIR. SO IF WE COULD ALL TAKE A PICTURE? THANK YOU. 

SUP. BURKE, CHAIR: I'M GOING TO CALL UP ITEM 9 THAT REQUIRED FOUR VOTES. THAT WILL BE MOVED BY MOLINA, SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. THAT'S ON ITEM NO. 9 ON OUR AGENDA THAT REQUIRED FOUR VOTES. I'D LIKE TO CALL UP BE WELL EXERCISE AND NUTRITION PROGRAM. AND BE WELL PROGRAM PARTICIPANTS ARE CYNTHIA BANKS, DIRECTOR OF COMMUNITY AND SENIOR SERVICES. SHE'S BUSY TODAY. SISKESY ALLEN, CITY OF INGLEWOOD. LISA YAREK, M.S.W. OF KAISER PERMANENTE AND DIRECTOR OF LONG-TERM CARE AT WOODLAND HILLS MEDICAL CENTER. BONNIE HART, NURSE, PRESIDENT OF FOOD AND NUTRITION MANAGEMENT SERVICES. AND SUE KENNEDY. AND ALSO HERE TODAY IN OUR AUDIENCE ARE ALL OF THE BE WELL PARTICIPANTS. PLEASE STAND BE WELL PARTICIPANTS. LET'S RECOGNIZE THEM. [APPLAUSE.] THANK YOU FOR BEING HERE. CONGRATULATIONS. BE WELL NUTRITION AND EXERCISE CLASS IS AN EXERCISE AND NUTRITION EDUCATION WEIGHT MANAGEMENT PROGRAM DESIGNED FOR SENIORS AT MODERATE TO HIGH NUTRITIONAL RISK. THESE SENIORS OFTEN HAVE CHRONIC DISEASE CONDITIONS SUCH AS HYPERTENSION, OBESITY, DIABETES, CARDIOVASCULAR DISEASE, ARTHRITIS AND OSTEOPOROSIS. HIGH SKILLED REGISTERED DIETICIANS, EXERCISE SPECIALISTS, AND OTHER MEDICAL PROFESSIONALS PROVIDE ONE-ON-ONE CONSULTATION AND MONITORING WITH THE CLIENT, WHO ATTENDS INTENSIVE NUTRITION, HEALTH, EDUCATION AND EXERCISE SESSIONS. THE COMMUNITY AND SERVICE AREA AGENCY IMPLEMENTATION OF THE BE WELL PILOT PROGRAM IS IN COLLABORATION WITH ITS COMMUNITY PARTNERS, THE CITY OF INGLEWOOD, KAISER PERMANENTE AND FOOD AND NUTRITION MANAGEMENT SERVICES. THE BE WELL CLASS PARTICIPANTS' OUTCOMES WILL BE PRESENTED TO AMERICAN DIABETES ASSOCIATION'S ANNUAL MEETING THIS FALL. IT'S WITH GREAT PLEASURE THAT I PRESENT THESE SCROLLS TO CYNTHIA BANKS, DIRECTOR OF LOS ANGELES COUNTY COMMUNITY AND SENIOR SERVICES AND ALL THE COLLABORATIVE COMMUNITY PARTNERS PARTICIPATING, AS WELL AS THE MEDICAL PROFESSIONALS AND BE WELL PROGRAM PARTICIPANTS FOR YOUR CONTRIBUTIONS. SO I WANT TO SAY TO BE WELL, WE KNOW HOW IMPORTANT EXERCISE IS AND THAT WE HAVE THIS DISTINGUISHED GROUP OF PARTICIPANTS. I'M GOING TO READ THEIR NAMES AGAIN BECAUSE THEY HAVE MADE IT POSSIBLE FOR THIS PROGRAM TO GO ON. AND FIRST OF COURSE CYNTHIA BANKS. WE ARE PRESENTING THIS SCROLL TO YOU. AND TO SIKESY ALLEN, CITY OF INGLEWOOD. THANK YOU FOR BEING HERE. [APPLAUSE.] LISA YAREK? SOCIAL WORK, KAISER PERMANENTE. THEY'RE ALWAYS RIGHT THERE. DIRECTOR OF LONG-TERM CARE AT WOODLAND HILLS MEDICAL CENTER, BONNIE HART. [APPLAUSE.] AND SUE KENNEDY. THANK YOU SO MUCH. PRESIDENT FOOD AND NUTRITION MANAGEMENT SERVICES. IT TAKES ALL OF US COMING TOGETHER. AND, CYNTHIA, WERE YOU GOING TO SAY A WORD? 

CYNTHIA BANKS: I WOULD. WHAT WE HAVE IN THE AUDIENCE, AND TWO INDIVIDUALS HERE UP ON THE STAGE, ARE INDIVIDUALS WHO TOOK A CHANCE TO MAKE THEIR LIVES BETTER BY BECOMING PART OF A PROGRAM THAT HELPED REDUCE THEIR BLOOD PRESSURE, INCREASE THEIR NUTRITION AND TO LOSE WEIGHT. AND WHAT WE HOPE TO DO IS TO SPREAD THIS PROGRAM THROUGHOUT THE COUNTY. SO AS OUR NUMBERS OF SENIORS GROW, THAT WE MAKE THIS PROGRAM AVAILABLE TO THEM. WE COULD NOT DO THIS, HOWEVER, WITHOUT THE PARTNERSHIP OF KAISER, THE CITY OF INGLEWOOD, AND BONNIE HART AND HER STAFF. AND SO I WOULD LIKE, STARTING WITH BONNIE HART, FOR HER JUST TO COME AND SAY A FEW WORDS. 

BONNIE HART: I'LL BE VERY BRIEF BUT I'M GOING TO CHALLENGE THE SUPERVISORS TODAY BECAUSE WE HAVE A SPECIAL LITTLE GIFT FOR THEM. ALL OF OUR SENIORS USE PEDOMETERS EVERY DAY OF THEIR LIFE. AND THEIR GOAL IS TO MAKE 10,000 STEPS A DAY. SO WE'RE GOING TO GIVE EACH OF THE SUPERVISORS ONE OF THEIR VERY OWN. SUPERVISOR BURKE? 

SUP. BURKE, CHAIR: OKAY. I CAN USE THIS. THANK YOU. 

BONNIE HART: SUPERVISOR BURKE COULD PROBABLY TEACH THIS CLASS, I'M SURE. 

SUP. MOLINA: GREAT. 

SUP. KNABE: VERY GOOD, THANK YOU. 

BONNIE HART: AND SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: THANK YOU. 

SUP. BURKE, CHAIR: SUPERVISOR YAROSLAVSKY RUNS EVERY MORNING. 

BONNIE HART: THANK YOU. WE HOPE EVERYBODY DOES SOMETHING LIKE THIS EVERY DAY OF THEIR LIFE BECAUSE IT MAKES A DIFFERENCE. THESE FOLKS HAVE PROVED IT. THANK YOU. 

CYNTHIA BANKS: LISA FROM KAISER? 

LISA YAREK: ON BEHALF OF KAISER PERMANENTE, WE ARE JUST SO PROUD TO BE A PARTNER IN THIS IN THIS GREAT PROGRAM. THEY APPROACHED US AND WE COULDN'T RESIST. MY INGLEWOOD MEDICAL OFFICE BUILDING OF KAISER PERMANENTE'S PHYSICIANS WHOLEHEARTEDLY SUPPORTED THIS. WHEN WE WENT TO THEM AND SAID WE'RE ENROLLING MORE MEMBERS. YOU'RE GOING TO HAVE TO WORK A LITTLE HARDER. YOU'VE GOT TO DRAW MORE LABS, YOU'RE GOING TO HAVE TO DO A LOT MORE WORK WITH THEM. THEY SAID "THAT'S GREAT, WE WANT THEM UP AND MOVING." THESE DAYS KAISER PERMANENTE'S DOCTORS WILL PRESCRIBE EXERCISE TO EVERY PATIENT THEY SEE ON A PRESCRIPTION PAD. SO THEY WANT US UP AND MOVING AND FIT. THANK YOU VERY MUCH. [APPLAUSE.] 

CYNTHIA BANKS: SIKESY ALLEN FROM INGLEWOOD? 

SIKESY ALLEN: GOOD MORNING. ON BEHALF OF THE CITY OF INGLEWOOD, I WOULD JUST LIKE TO SAY THAT IT IS A PLEASURE TO BE HONORED BY THE BOARD OF SUPERVISORS FOR THE HARD WORK THAT OUR SENIORS HAVE PUT IN TO CHANGING THEIR OWN LIVES. AND AS WE PASS THE PEDOMETERS TO THE SUPERVISORS, WE'RE LOOKING FOR THEM TO TAKE ON THAT SAME CHALLENGE. AND WE LOOK TO SPREAD THIS THROUGHOUT THE COUNTY OF LOS ANGELES, AND NOT JUST IN THE CITY OF INGLEWOOD SO WE CAN HAVE A HEALTHY COMMUNITY. THANK YOU. [APPLAUSE.] 

CYNTHIA BANKS: WE'D LIKE TWO OF THE PARTICIPANTS, THEY'RE RIGHT HERE. WOULD YOU COME AND JUST SAY A FEW WORDS? 

MARTHA STEWART: GOOD MORNING. MY NAME IS MARTHA STEWART, AND I AM A MEMBER OF THE BE WELL CLASS. I HAVE ENJOYED THE CLASS AND BENEFITED A GREAT DEAL. THE MOST IMPORTANT PART IN THE CLASS TO ME WAS THE WALKING. AT FIRST I WALKED VERY LITTLE. THE LONGER I STAYED IN THE PROGRAM, THE MORE I WALKED. I LOST WEIGHT. MY DIABETES IS UNDER CONTROL. AND IT'S AN EXCELLENT PROGRAM AND I'M HAPPY TO BE A MEMBER. 

ELAINE HEISEROVIT: MY NAME IS ELAINE HEISEROVIT. I SAW THE BE WELL PROGRAM MANY YEARS AGO, IT SEEMS. BUT IT HAS BEEN BENEFICIAL TO ME ESPECIALLY NOW SINCE I'VE HAD SURGERY. BUT IF I HAD NOT HAD THE BE WELL PROGRAM TO STRENGTHEN ME, I WOULD NOT HAVE BEEN ABLE TO GO THROUGH THIS. AND IT IS A VERY, VERY GOOD PROGRAM. 

SUP. BURKE, CHAIR: THAT CONCLUDES MY PRESENTATIONS. SUPERVISOR KNABE? 

SUP. KNABE: THANK YOU, MADAME CHAIR, MEMBERS OF THE BOARD. IT'S MY PLEASURE TO INVITE UP INGA AND CORINNA CRISTIANO FROM NINO'S ITALIAN RESTAURANT IN THE GREAT CITY OF LONG BEACH. NINO, UNFORTUNATELY, IS NOT ABLE TO JOIN US, A LITTLE UNDER THE WEATHER TODAY. BUT WE HAVE INGA AND CORINNA HERE TO JOIN US. THE CRISTIANO FAMILY CAME TO THE UNITED STATES IN MAY OF 1957 WITH TWO SMALL CHILDREN. NEW LANGUAGE NEEDS AND THE AMERICAN DREAM IN THEIR POCKET. THEY STARTED THEIR RESTAURANT ON JULY 31ST, 1958. SINCE THEN, THEY HAVE SERVED MORE THAN 2,750,000 DELICIOUS ITALIAN MEALS OVER THEIR 50 YEARS IN BUSINESS. THAT'S A LOT OF PASTA. THE CRISTIANO FAMILY LOVES THEIR ADOPTED HOMELAND AND COMMUNITY IN SUCH A WAY AS TO UNITE DIVERSE POPULATIONS. THROUGHOUT THE DECADES, AND THIS IS DEMONSTRATED IN THEIR LIFE, THEIR CULTURE AND THE VITALITY OF MAKING MULTIGENERATIONAL PATRONS AT NINO'S ALWAYS WELCOME AND FEELING VERY WELCOME. RECENTLY THEY ROLLED BACK THEIR PRICES FOR 50 YEARS. AND I UNDERSTAND THERE WAS A LINE OF ALMOST A MILE LONG. 2,000 MEALS WERE SERVED IN ONE DAY. SO ON BEHALF OF MYSELF AND MY COLLEAGUES ON THE BOARD AND THE CITIZENS OF THE GREAT COUNTY OF LOS ANGELES, WE'D LIKE TO CONGRATULATE NINO'S RESTAURANT INGA AND CORINNA FOR BEING HERE TODAY, ON 50 YEARS OF NOT ONLY GREAT FOOD BUT THESE FOLKS ARE TRUE PATRONS AND INCREDIBLE COMMUNITY CITIZENS. AND WE APPRECIATE ALL THEY DO EACH AND EVERY DAY NOT ONLY IN THE GREAT FOOD AS I SAID BUT WHAT THEY DO FOR THE COMMUNITY AND THE SURROUNDING AREAS. SO CONGRATULATIONS. 50 WONDERFUL YEARS OF SERVICE. [APPLAUSE.] 

CORINNA CRISTIANO: ON BEHALF OF MY PARENTS, I'D LIKE TO THANK YOU FOR THIS RECOGNITION. THEY TRULY ARE AMAZING ROLE MODELS IN OUR LIVES, NOT JUST MY OWN BUT IN OUR COMMUNITY. THEY REALLY SHOWED US WHAT IT MEANT TO BE ACTIVE CITIZENS IN OUR COMMUNITY AND TAKING THE RESTAURANT BUSINESS TO NEW LEVELS AND ENGAGING ALL OF OUR CUSTOMERS AND OUR STAFF OVER THE YEARS. IT IS FAMILY FOR US. WE ARE VERY APPRECIATIVE FOR OUR COUNTRY. WE'D ALSO LIKE TO THANK SUPERVISOR DON KNABE FOR HIS LEADERSHIP AND WHAT HE DEMONSTRATES IN OUR CITY. WE REALLY VALUE EVERYONE'S WORK TODAY AND THANK YOU FOR BEING A PART OF OUR LIVES. 

SUP. BURKE, CHAIR: SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: WELL ONCE AGAIN IT'S AN OPPORTUNITY THAT WE HAVE TO RECOGNIZE THE TRADITION AND THE HERITAGE OF LOS ANGELES COUNTY AND REACQUAINT THE PEOPLE OF LOS ANGELES COUNTY WITH OUR HISTORY. MANY PEOPLE THINK THE HISTORY OF LOS ANGELES COUNTY IS LOS ANGELES CITY WHEN IN FACT LOS ANGELES CITY IS JUST ONE OF OUR 88 CITIES AND IS NOT, LET'S SAY, WHEN THEY USE THEIR ECONOMIC STATISTICS, IT'S THE COUNTY THAT IS THE 17TH LARGEST ECONOMY IN THE WORLD, NOT ONE OF OUR INDIVIDUAL CITIES. BUT MANY YEARS AGO, MANY YEARS AGO, 237 YEARS AGO, WE HAD A RECOGNITION OF A FOUNDING OF LOS ANGELES COUNTY WITH THE OLDEST SETTLEMENT, WHICH WAS THE SAN GABRIEL MISSION. AND WE SALUTE THIS FOUNDING EVERY SEPTEMBER WHEN THERE IS A MARCH BETWEEN SAN GABRIEL TO ALVERA STREET, WHICH WE ALL PARTICIPATE IN, RECOGNIZING THAT WITH THE LEADERS FROM THE CITY OF SAN GABRIEL, THE CITY OF LOS ANGELES AND THE COUNTY OF LOS ANGELES. AND SO TODAY LET ME FIRST RECOGNIZE WE HAVE THE MAYOR OF SAN GABRIEL, HARRY BALDWIN AND JULIE COSTANZO, THE VICE MAYOR, AND COUNCILMAN ALBERT WONG AND DAVID GUTIERREZ, AND THE ADMINISTRATIVE MANAGER, CYNTHIA SMITH. AND FROM THE SAN GABRIEL MISSION, STILL A MISSION TODAY, 237 YEARS OLD, FATHER PAULSEN AND MICHAEL ABROL, THE EXECUTIVE DIRECTOR, AND ANNETTE RACON, THE ROYAL COURT COORDINATOR, AND OUR 2007-2008 FIESTA ROYAL COURT, THERE'S THE QUEEN ILLIANA RAMOS, PRINCESS VIVIAN PIENDA, PRINCESS ANDREA KARI, AND PRINCESS JILANA HUGHES. AND FROM LOS POBLADORES, WE HAVE PRESIDENT IRENE SEPULVEDA HASTINGS, PAUL GUZMAN, AND CONNIE NESS. AS I SAID, THEY'RE HERE TO RECOGNIZE THE 237TH ANNIVERSARY OF THE COUNTY OF LOS ANGELES' OLDEST SETTLEMENT, THE SAN GABRIEL MISSION, AND SALUTE OUR L.A. COUNTY'S FOUNDING FAMILIES, THE LOS POBLADORES 200. THIS WAS ESTABLISHED, THIS MISSION, ON SEPTEMBER 8TH, 1771 BY THE NATIVE SHOSHONE PEOPLE AND THE FRANCISCAN PRIESTS AS THE CULTURAL AND SPIRITUAL CENTER OF LOS ANGELES COUNTY. 10 YEARS LATER IN 1781, FATHERS JOSEPH DE LA SOMERA AND PEDRO CAMBRON, LED SEVERAL INDIAN ACOLYTES AND 11 FAMILIES, LOS POBLADORES ON A NINE-MILE WALK FROM THE SAN GABRIEL MISSION TO WHAT IS NOW ALVERA STREET. THERE THEY FOUNDED THE CITY OF OUR LADY QUEEN OF THE ANGELS. AND ON SEPTEMBER 4TH, THE DESCENDENTS OF THE LOS POBLADORES REENACTED THEIR ANCESTORS' HISTORIC WALK TO COMMEMORATE THE FOUNDING OF LOS ANGELES COUNTY'S CITY OF LOS ANGELES. SO THE BOARD IS GOING TO RECOGNIZE THEM. AND I KNOW WE HAVE THE NISEI WEEK QUEEN AND HER COURT THAT WILL BE COMING UP SHORTLY. WE ENCOURAGE EVERYBODY TO JOIN US IN THIS EARLY WALK ON SEPTEMBER. SEPTEMBER 4TH, WE GATHER AT THE SAN GABRIEL MISSION, AND JOIN US FOR THE WALK. IT'S JUST A COUPLE HOUR WALK. THERE ARE SOME PEOPLE WHO JOIN THE WALK FOR THE FIRST BLOCK WHEN THE PICTURES ARE TAKEN. THEN THEY JUMP IN THE CAR TO RACE AT THE END TO GREET THE PEOPLE WHEN THEY END. BUT WE ENCOURAGE EVERYBODY TO WALK. IT'S A FUN WALK. AND AS YOU JUST HAD SEEN FROM THE PREVIOUS PRESENTATION, THEY HAVE LITTLE WALKERS THAT WE CAN PUT ON AND TELL YOU HOW MANY STEPS YOU'VE MADE. ANYWAY, LET ME GIVE THE PROCLAMATIONS, FIRST TO THE LOS POBLADORES. MS. HASTINGS? THERE YOU GO. AND SAN GABRIEL MISSION, FATHER PAULSEN. AND TO THE CITY OF SAN GABRIEL. ALBERT AND DAVID. SO FIRST SHALL WE CALL ON THE MAYOR? 

SPEAKER: THANK YOU, SUPERVISOR ANTONOVICH. WE'VE BEEN DOING THIS WALK, IT STARTED IN 1981 AND IT'S BEEN EXPANDING EVERY YEAR. AND ONE OF THE REASONS IT'S REALLY BEEN EXPANDING AND SUCCESS IS YOUR SUPPORT AND YOUR HELP IN PROMOTING THIS WALK AND ACTUALLY PARTICIPATING IN THE WALK, ALSO. AND THE ENTIRE BOARD OF SUPERVISORS, WITH THEIR SUPPORT ALSO, IN PROMOTING THIS. BUT IT'S BEEN A TREMENDOUS EVENT TO REALLY CELEBRATE THE HISTORY OF THE LOS ANGELES, AND ACTUALLY ORANGE COUNTY, AREA. BECAUSE THE SAN GABRIEL MISSION WAS FIRST FOUNDED GOVERNED ALL OF L.A. COUNTY, ORANGE COUNTY, AND PARTS OF RIVERSIDE AND SAN BERNARDINO. SO IT'S SORT OF LIKE THE ORIGINAL SCAG AS WE LOOK AT IT. 

SUP. ANTONOVICH: BUT MORE PRODUCTIVE. 

SPEAKER: NOT REALLY. BUT WE REALLY DO WANT TO THANK YOU FOR ALL YOUR SUPPORT AND PARTICIPATION. AND WE LOOK FORWARD TO SEEING EVERYBODY. THIS YEAR WE'RE STARTING AT 6:00 IN THE MORNING AS WE USED TO. SO THAT MEANS IT'S GOING TO BE A HOT DAY LIKE IT IS MANY TIMES, WE'RE GOING TO HAVE COOL WEATHER MOST OF THE WAY. SO WE HOPE TO SEE YOU ALL IN THE MISSION PLAZA, WHICH IS RIGHT BY THE SAN GABRIEL MISSION, FOR THE WALK INTO LOS ANGELES. THANK YOU AGAIN. [APPLAUSE.] 

SPEAKER: GOOD MORNING. AND I HOPE THE WEATHER GETS A LITTLE COOLER SO WE CAN MAKE IT WITHOUT BEING TOO HOT THIS YEAR. LAST YEAR IT WAS TERRIBLE. SO A LOT OF US DIDN'T GET TO WALK THE FULL LENGTH. SO SEE YOU THERE AT 6:00 ON THE FIRST. MONDAY MORNING. 

SUP. ANTONOVICH: OKAY. WE'LL BE THERE. QUEEN RAMOS? 

ILLIANA RAMOS: HI. GOOD MORNING. IT'S AN HONOR TO BE HERE REPRESENTING OUR CITY OF SAN GABRIEL AND THE PARISH. AND IT'S BEEN A PLEASURE TO BE HERE. 

SUP. ANTONOVICH: COOL. FATHER RAMOS? FATHER PAULSEN, HERE WE GO. FATHER PAULSEN. 

FATHER PAULSEN: ON BEHALF OF REVEREND STEVE MISKENAN, OUR PASTOR OF SAN GABRIEL, AND ALL THE CLARETIAN FATHERS AND THE FIESTA EXECUTIVE COMMITTEE AND ALL THE PARISHIONERS OF SAN GABRIEL MISSION, I WOULD LIKE TO THANK WHOLEHEARTEDLY SUPERVISOR ANTONOVICH AND THE WHOLE BOARD OF SUPERVISORS FOR THEIR ENCOURAGEMENT AND CONTINUED SUPPORT FOR SAN GABRIEL MISSION AND ESPECIALLY FOR THE FIESTA. AND THIS YEAR'S FIESTA IS VERY SPECIAL. IT IS 237TH YEAR OF THE FOUNDING OF THE SAN GABRIEL MISSION AND ALSO IT IS THE 100TH ANNIVERSARY OF CLARETIAN PRESENCE AT THE MISSION. AND SO I WOULD LIKE TO TAKE THIS OPPORTUNITY TO ESPECIALLY INVITE SUPERVISOR ANTONOVICH AND FAMILY, THE WHOLE BOARD OF DIRECTORS AND ALL THE CITIZENS OF THE COUNTY OF LOS ANGELES TO COME TO THE FIESTA THAT HAPPENS ON AUGUST 29TH, 30TH AND 31ST. THANK YOU VERY MUCH AND GOD BLESS YOU. I WOULD ALSO LIKE TO MAKE A LITTLE TOKEN OF OUR APPRECIATION, OUR THANKS, A LITTLE GIFT TO SUPERVISOR ANTONOVICH. AND I REQUEST ILLIANA RAMOS, OUR QUEEN, TO PRESENT IT. 

SUP. ANTONOVICH: DO A GROUP PICTURE? 

PAUL GUZMAN: GOOD MORNING. MY NAME IS PAUL GUZMAN. I AM PAST PRESIDENT OF LOS POBLADORES. I'M ALSO A DIRECT DESCENDENT OF FOUR OF THE FOUNDING 11 FAMILIES. ALSO A GABRIELINO-TONGVA INDIAN. ON BEHALF OF THOUSANDS OF DESCENDANTS WHO SPREAD ACROSS THE COUNTRY, IN, CALIFORNIA EVEN ONE IN DUBAI. AND ALSO MY NIECE, DEBBY WUDALI, WHO WORKS HERE AT THE BOARD OF SUPERVISORS' OFFICE. 

SUP. ANTONOVICH: WHO DOES SHE WORK FOR? 

PAUL GUZMAN: SHE WORKS FOR SUPERVISOR ANTONOVICH. [LAUGHTER.] HOPE EVERYBODY CAN MAKE IT TO SEPTEMBER 1ST AT 6:00 IN THE MORNING FOR THE NINE-MILE WALK THANK YOU. 

SUP. ANTONOVICH: NOW IT'S AN OPPORTUNITY TO WELCOME THE 68TH ANNUAL NISEI WEEK JAPANESE FESTIVAL COURT REPRESENTING THE RICH CULTURAL AND PROUD HERITAGE OF THE JAPANESE AMERICANS. THE FESTIVAL PROMOTES JAPANESE CULTURE THROUGH SEVERAL EVENTS INCLUDING CULTURAL EXHIBITS, STREET ARTS FESTIVAL, GRAND PARADE AND AN AUTOMOBILE SHOW. FRANCIS HASHIMOTO IS THE PRESIDENT OF THE LITTLE TOKYO BUSINESS ASSOCIATION, IS WITH US THIS MORNING ALONG WITH HELEN OTA, WHO IS PRESIDENT OF THE JAPANESE FOUNDATION. THEY HAD A WONDERFUL PARADE. I'M SURE MANY OF YOU WERE AT THE PARADE OR HAVE SEEN IT ON TELEVISION THIS PAST SUNDAY. MY FAMILY AND I HAD A WONDERFUL TIME THERE. AND THEN LAST NIGHT WAS THE DINNER THAT THEY HAD AT THE OLD NEW OTANI, WHICH IS NOW THE KYOTO GRAND HOTEL THAT'S BEEN RENAMED, A NEW HOTEL. AND IT WAS A WONDERFUL DINNER. AND THEY RECOGNIZED THE INDIVIDUALS THAT WERE PART OF THE -- THEY WERE HONORING THIS YEAR. ONE OF THEM WAS 94 YEARS OLD WHO HAD MORE ENERGY THAN THE COURT OR ME OR ANYBODY ELSE AT THAT EVENT. BECAUSE THE DINNER WENT UNTIL AFTER 9:30 AND HE WAS AS STRONG AS HE WAS AT THE BEGINNING. I MEAN, A GREAT ROLE MODEL. A GREAT ROLE MODEL. SO TODAY WE'RE GOING TO INTRODUCE THE INDIVIDUALS THAT ARE HERE TODAY. FIRST, OUR QUEEN IS JILL KAORI HIRAIZUMI, WHO IS 22 YEARS OLD, GRADUATE OF UNIVERSITY OF CALIFORNIA, SAN DIEGO. MAJORS IN JAPANESE STUDIES AND POLITICAL SCIENCE, WILL BE ATTENDING LAW SCHOOL IN 2009. WANTS TO FOCUS ON INTERNATIONAL LAW. SHE'S NOW TEACHING LANGUAGE CLASSES AND TRAINS FOR MARATHONS, READS BIOGRAPHIES AND INSPIRATIONAL LEADERS IN TRAVELS. AND HER PLATFORM WAS CHOSEN TO SUPPORT THIS YEAR IS THE ADVANCEMENT VIA INDIVIDUAL DETERMINATION. SO FIRST LET ME GIVE TO THE QUEEN, JILL. [APPLAUSE.] OKAY FIRST YEAR'S PRINCESS IS KIMBERLY MIDORI KITAURA, GRADUATE OF THE UNIVERSITY OF CALIFORNIA IRVINE, WHERE SHE MAJORED IN APPLIED ECOLOGY. SHE WILL BE EMPLOYED BY BROADCOM AND ATTEND IN THE EVENING TO PURSUE BECOMING A NURSE PRACTITIONER. SHE ENJOYS PLAYING BASKETBALL, KARAOKE, GOING OUT EATING AND DOING THE PUZZLES. SHE HAS DECIDED TO SUPPORT THIS YEAR THE NATURAL RESOURCES DEFENSE COUNCIL. SO KIMBERLY. [APPLAUSE.] MISS TOMODACHI, WHICH IS MISS FRIENDSHIP, IS LINDY SUMIKO FUJIMOTO. AND SHE WAS A -- RECEIVED HER BACHELOR'S DEGREE FROM CALIFORNIA STATE UNIVERSITY NORTHRIDGE, CSUN. AND SHE'S IN ASIAN AMERICAN STUDIES. SHE'S ATTENDING CLASS AT EAST/WEST PLAYERS TO DEVELOP HER PERFORMANCE SKILLS IN THE HOPE OF BECOMING A PROFESSIONAL ACTOR. HER FAVORITE PAST TIMES INCLUDE HISTORICAL NOVELS, DRAWING, BAKING, WATCHING EPIC MOVIES AND ICE SKATING. AND SHE'S CHOSEN THE RONALD MCDONALD CHARITIES AS HER PLATFORM THIS YEAR. CINDY? MINDY? [APPLAUSE.] OKAY. OUR NEXT PRINCESS IS MARISSA ASAKO ISHII, WHO GRADUATED FROM THE UNIVERSITY OF THE PACIFIC WITH A DOCTOR OF PHARMACY DEGREE. SO CURRENTLY SHE IS A DOCTOR. CURRENTLY WORKS AS A PHARMACIST AT KAISER PERMANENTE IN ORANGE COUNTY. AND WHEN SHE'S NOT EMPLOYED, SHE ENJOYS PLAYING MOST SPORTS, BASKETBALL, SWIMMING SURFING, AND RUNNING, ALONG WITH SPENDING TIME READING AND WATCHING ANNIE. SHE'S CHOSEN THE AMERICAN DIABETES ASSOCIATION AS HER PLATFORM OF THE YEAR. [APPLAUSE.] KIE FLORA ITO ATTENDS CALIFORNIA STATE CAL POLY, WHERE SHE IS STUDYING BROADCAST JOURNALISM AND COMMUNICATIONS. SHE WANTS TO WORK THE IN THE MEDIA AND ENTERTAINMENT INDUSTRY AS A PRIVATE LANGUAGE TUTOR AND VOLUNTEERS IN HER SPARE TIME AT HIRO IMMEDIATE CARE FACILITY. SHE ENJOYS VISUAL ARTS, MUSIC, CARING FOR HER PETS AND COOKING. THIS PLATFORM FOR HER THIS YEAR IS THE AMERICAN LIVER FOUNDATION. NEXT IS LISA TAKEHANA, WHO ATTENDS UNIVERSITY OF SOUTHERN CALIFORNIA WHERE SHE'S STUDYING FINE ARTS, SPECIALIZING IN GRAPHIC DESIGN AND DRAWING. SHE ALSO STUDIES VIDEO GAME DESIGN, MANAGEMENT, AND HOPES TO PURSUE AGREE AS AN ILLUSTRATOR AND GRAPHIC DESIGNER IN THE ENTERTAINMENT INDUSTRY. SHE ENJOYS TRAVELING TO FOREIGN COUNTRIES, VISITING MUSEUMS AND GALLERIES. AND SHE HAS CHOSEN THE UNITED STATES ORGANIZATION AS THE PLATFORM SHE PLANS TO SUPPORT FOR THIS YEAR. DO YOU WANT TO SAY SOMETHING? 

JILL KAORI HIRAIZUMI: GOOD MORNING, HONORABLE SUPERVISOR MIKE ANTONOVICH, HONORABLE SUPERVISOR GLORIA MOLINA, AND HONORABLE SUPERVISORS. ON BEHALF OF THE 2008 COURT, I WOULD LIKE TO THANK YOU FOR YOUR CONTINUOUS SUPPORT FOR THE LITTLE TOKYO COMMUNITY AND FOR NISEI WEEK. THANK YOU VERY MUCH. AND AT THIS TIME WE WOULD LIKE TO PRESENT TO YOU ALL COMMEMORATIVE NISEI WEEK BOOKLETS. 

SUP. ANTONOVICH: WOULD YOU LIKE TO SAY A FEW WORDS? HELEN WILL DO THE TALKING. 

HELEN OTA: GOOD MORNING, HONORABLE MIKE ANTONOVICH, HONORABLE GLORIA MOLINA, HONORABLE SUPERVISORS. ON BEHALF OF THE NISEI WEEK FOUNDATION, THANK YOU VERY MUCH FOR YOUR CONTINUED SUPPORT OF THE NISEI WEEK JAPANESE FESTIVAL. LAST NIGHT WE WERE HONORED TO HAVE SUPERVISOR MIKE ANTONOVICH AT OUR AWARDS DINNER AS WE RECOGNIZED INDIVIDUALS AND ORGANIZATIONS WHO GIVE BACK TO THE JAPANESE-AMERICAN COMMUNITY. WE LOOK FORWARD TO SEEING YOU THIS WEEKEND AT OUR NISEI WEEK JAPANESE FESTIVAL THIS WEEKEND AS IT CLOSES ON SUNDAY, AUGUST 24TH WITH OUR CLOSING CEREMONY ONDO, OUR JAPANESE DANCE. ALSO, SUPERVISOR ANTONOVICH, YOU MENTIONED THE SAN GABRIEL MISSION WALK IN SEPTEMBER, SO WE HOPE TO JOIN YOU THEN. AGAIN, YES, I WILL TRY TO DO MY BEST TO WALK. AND AGAIN ON BEHALF OF THE NISEI WEEK FOUNDATION, THANK YOU VERY MUCH FOR YOUR SUPPORT. [APPLAUSE.] 

FRANCIS HASHIMOTO: I WOULD LIKE, BECAUSE I SEE ALL OUR GREAT FRIENDS HERE, YVONNE, GLORIA, DON, I REALLY WANT TO THANK YOU. NISEI WEEK, YEAR AFTER YEAR, YOU'VE BEEN REALLY SUPPORTIVE. WE REALLY WANT TO THANK YOU. THIS IS ONE OUR HIGHLIGHTS COMING HERE TO PERSONALLY THANK YOU. SO WE THANK YOU FOR YOUR SUPPORT. AND THANK YOU FOR YOUR CONTINUING SUPPORT IN THE FUTURE. THIS IS OUR 68TH YEAR. SO WE LOOK FORWARD TO MANY MORE. YES, THAT WAS BEFORE I WAS BORN. [LAUGHTER.] [APPLAUSE.] 

SUP. ANTONOVICH: NOW IF ONE OF OUR PRINCESSES WANT TO ADOPT A LITTLE CHIHUAHUA MIX, WE HAVE A LITTLE GIRL WHO'S ONLY 16 WEEKS OLD WHO IS LOOKING FOR A HOME. SHE COMES WITH A LITTLE DIAMOND OR PEARL NECKLACE. AND SHE'D WOULD MAKE A NICE MASCOT FOR THE COURT. AND SHE KIND OF BLENDS IN WITH SOME OF THOSE KIMONOS THAT YOU HAVE. HER EARS ARE ALL PERKED UP BECAUSE SHE THINKS MAYBE THERE'S A HOME OUT THERE. SO YOU CAN CALL 562-728-4644. OR ANYBODY IN THE AUDIENCE WHO WOULD LIKE TO ADOPT LITTLE LEXI. IS IT LITTLE LEXI? LOOK GOOD IN LITTLE TOKYO RUNNING AROUND. LOOK, HELEN. LOOK AT HIM. SHE'S LOOKING AT YOU WITH THOSE EYES, HELEN. I MEAN, IT'S CLOSE TO THE MUSIC CENTER. THE MUSIC CENTER WON'T MIND YOU WHEN YOU WORK THERE HAVING HER. LOOK AT HER. LOOK AT THOSE LITTLE EYES. OH. LOOK, YVONNE. SHE LIKES BOATS. TAKE HER ON THE BOAT, HUH? 

SUP. BURKE, CHAIR: A LITTLE BIT SMALL FOR ME. 

SUP. ANTONOVICH: A LITTLE SMALL? HOW ABOUT HELEN? THANK YOU. 

SUP. BURKE, CHAIR: WHILE WE'RE WAITING, I THINK SUPERVISOR ANTONOVICH HAS FINISHED. MIRIAM ON OUR STAFF IS LEAVING AFTER 12 YEARS. WE WANT TO SAY TO HER THAT WE CERTAINLY HAVE ENJOYED WORKING WITH HER AND WE WANT TO WISH HER THE BEST AS SHE GOES OVER TO THE CITY OF LOS ANGELES TO JOIN THE MAYOR AS THE DEPUTY MAYOR FOR CHILDREN EDUCATION. AND MIRIAM, WE CERTAINLY THANK YOU WELL. 

SPEAKER: THANK YOU. [APPLAUSE.] 

SPEAKER: THE 12 YEARS THAT I'VE BEEN A DEPUTY FOR SUPERVISOR BURKE HAVE GONE BY SO FAST. I REMEMBER HEARING MATTHEW JOHNSON SAY ONE TIME THAT WHEN HE WAS ON THE LAKERS, THE BEST PART WAS BEING PART OF A GREAT TEAM. I DEFINITELY FEEL THAT, THAT I'VE HAD THE PRIVILEGE OF BEING PART OF A GREAT TEAM. THE TEAM THAT INCLUDED, I MIGHT ADD, ALL WHAT WE CALLED CHI DEPS. THE CHILDREN'S DEPUTIES FROM EVERY OFFICE. WE MAKE A GREAT TEAM, TOO. I WON'T FORGET THE LESSONS THAT I'VE LEARNED HERE. I'LL CARE AT THIS BRIDGE OVER TO THE CITY AND I PROMISE I'LL BE BACK. THANKS TO EACH OF THE SUPERVISORS FOR GIVING ME SUCH A GREAT LIFE AND EXPERIENCE. IT HAS REALLY BEEN LIKE BEING BACK STAGE AT A ROCK CONCERT. GOD BLESS, EVERYBODY. [APPLAUSE.] 

SUP. BURKE, CHAIR: SUPERVISOR MOLINA, YOU'RE UP FIRST WITH YOUR ADJOURNMENTS. 

SUP. MOLINA: I DON'T THINK I HAVE ANY ADJOURNMENTS. I DON'T HAVE ANY. 

SUP. BURKE, CHAIR: ANY ITEMS YOU WANT TO CALL UP? 

SUP. MOLINA: NO. ALL MY ITEMS ARE UP, I THINK. 

SUP. BURKE, CHAIR: I DO HAVE SOME ADJOURNMENTS THAT I DO WANT TO CALL. FIRST, THAT WE ADJOURN IN MEMORY OF EMMA LEE WALKER. AND SHE IS THE LOVING MOTHER OF MY DEPUTY, RENITA BOWLIN. SHE WAS A DEVOTED WIFE, MOTHER, GRANDMOTHER, GREAT GRANDMOTHER AND RESIDENT OF THE SECOND DISTRICT SINCE 1959. SHE WORKED IN VARIOUS CAPACITIES FOR U.C.L.A. AND THE CITY OF INGLEWOOD UNTIL HER RETIREMENT IN 1998. SHE WAS SMALL IN STATURE BUT WAS KNOWN BY MANY TO BE THE BIGGEST GIVER OF HER TIME, TALENT AND LOVE. ON SEVERAL OCCASIONS SHE OPENED HER HOME TO HOMELESS YOUTH AND WAS QUICK TO GIVE OUT HER RESOURCES. AS A MEMBER OF THE ONTARIO CHRISTIAN CENTER, MRS. WALKER SERVED FAITHFULLY IN THE YOUNG AT HEART MINISTRY AND AS A DEDICATED TEACHER AT ITS CHILDREN'S CHURCH. MRS. WALKER LEAVES TO CHERISH HER MEMORY FIVE CHILDREN, TONY, JUNE, RENITA, ROBERT, AND VINCENT, AND A HOST OF FAMILY AND FRIENDS WHO WILL MISS HER. AND PASTOR REVEREND DR. PERCY HILL, WHO PASSED AWAY ON JULY 26TH. DR. HILL WAS PASTOR OF COCHRAN AVENUE BAPTIST CHURCH FOR OVER 25 YEARS AND HE WAS IN THE MINISTRY FOR 30 YEARS. HE WAS A DEVOTED HUSBAND TO HIS WIFE, PATRICIA HILL; A LOVING FATHER TO HIS DAUGHTERS, PATRICIA HILL HALEY, AND PHYLLIS HILL; AND ADORING GRANDFATHER TO HIS ONLY GRANDDAUGHTER, SERAPHIM; AND LOVING BROTHER TO HIS ONLY SISTER, SHARON HILL ADAMS; AND LOVING FRIEND AND PASTOR TO THE HUNDREDS OF MEMBERS, IF NOT THOUSANDS, OF THE COCHRAN AVENUE BAPTIST CHURCH. AND DEACON HERMAN ALLEN SR. WHO PASSED AWAY AUGUST 13TH. HE WAS A DEVOTED MEMBER OF COMMUNITY BAPTIST CHURCH AND LONG-TIME RESIDENT OF THE SECOND DISTRICT. HE LEAVES TO CHERISH HIS MEMORY HIS WIFE, OLLIE ALLEN, AND TWO DAUGHTERS, THREE SONS, SEVEN GRANDCHILDREN AND TWO GREAT GRANDCHILDREN. AND WE WANT TO CERTAINLY -- ALL MEMBERS I'M GOING TO ASK TO JOIN IN THIS FOR ALBERT WHITE, THE LOVING FATHER OF OUR COUNTY LOBBYIST, SUSAN WHITE, WHO RECENTLY PASSED AWAY. HE LEAVES TO CHERISH HIS MEMORY HIS DAUGHTERS, SUSAN, BETH ANN GIBBS, AND AMY HANIS. ALL MEMBERS. SO ORDERED. WE HAVE A SPECIAL ORDER AT 11, BUT I'D LIKE TO GET SOME OF THE ITEMS THAT WE HAVE HERE THAT WE'RE HOLDING. ITEM 1, I'D LIKE DR. CLAVREUL, WOULD YOU LIKE TO COME UP? YOU HAVE THREE ITEMS. AND ITEM 1, ITEM 17 AND ITEM 23. 

DR. GENEVIEVE CLAVREUL: GOOD MORNING, BOARD OF SUPERVISORS, DR. GENEVIEVE CLAVREUL. I AM CONCERNED ABOUT THE APPOINTMENT OF MISS PATRICIA MILLER TO THE CHILD SUPPORT ADVISORY BOARD. AND ONE OF THE REASONS IS BECAUSE THERE IS ABSOLUTELY NO INFORMATION ON MISS MILLER. WE HAVE NO STATEMENT OF QUALIFICATION. WE HAVE ABSOLUTELY NOTHING. AND THIS IS THE ONLY ONE, OF ALL THE PEOPLE NOMINATED, WHERE THERE IS NO -- 

SUP. BURKE, CHAIR: ALL RIGHT. WE'LL CERTAINLY GIVE YOU THAT BACKGROUND. SHE'S A MEMBER OF OUR STAFF, OUR HEALTH DEPUTIES. AND WE'LL GET YOU A COPY OF HER RESUME. 

DR. GENEVIEVE CLAVREUL: OKAY. THAT'S FOR NO. 1. 

SUP. BURKE, CHAIR: SHE WORKED FOR CONGRESSMAN WILLIAM DIXON AND BEFORE SHE CAME TO WORK HERE. 

DR. GENEVIEVE CLAVREUL: I KNOW SHE WORKED FOR MR. DYMALLY, SHE WORKED FOR MR. DIXON, AND FOR DIANE WATSON AND THEN FOR YOU. BUT I DON'T KNOW NOTHING ABOUT HER QUALIFICATIONS AND THEY DON'T KNOW NOTHING ABOUT HER QUALIFICATIONS. THAT'S WHY I'M QUESTIONING IT. 

SUP. BURKE, CHAIR: I'LL GET YOU HER RESUME. 

DR. GENEVIEVE CLAVREUL: I KNOW IT'S A POSITION SHE OBTAINED. I JUST WANT TO KNOW WHAT THE QUALIFICATIONS ARE AND IF THERE IS A CONFLICT OF INTEREST. 

SUP. BURKE, CHAIR: IS THERE ANYTHING ELSE ON ITEM 1? 

DR. GENEVIEVE CLAVREUL: NO. THAT WAS ALL. 

SUP. BURKE, CHAIR: MOVED BY BURKE. SECONDED BY MOLINA; WITHOUT OBJECTION, SO ORDERED ON ITEM 1. YOU HAVE ITEM 17? 

DR. GENEVIEVE CLAVREUL: YES. ON ITEM 17 -- OH AND I LEFT ONE OF MY DOCUMENTS BACK THERE. ON ITEM 17, I AM KIND OF SURPRISED OF THE AMOUNT WHICH IS BEING ALLOCATED. I KNOW YOU ARE NOT CONCERNED BECAUSE THERE IS NO NET COUNTY COST, BUT, STILL, I AM SURPRISED THAT IN ADDITION TO THE SALARY, SHE WILL BE GETTING A TOTAL OF $181,938. I THINK IT'S PRETTY STEEP. AND I WOULD LIKE TO KNOW WHY SHE WAS NOT INCORPORATED WHEN SHE WAS HIRED. THAT'S OF GREAT CONCERN. AND ON ITEM 23? 

SUP. BURKE, CHAIR: MOVED BY KNABE ON 17. SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. ITEM 23? 

DR. GENEVIEVE CLAVREUL: YES. ON ITEM 23, HAVING TO DO WITH HEALTHCARE, AGAIN WE HAVE BEEN -- CONTRACTS ARE BEING RENEWED. CONTRACTS BEING EXTENDED. AND ON THIS ONE, IT'S PENDING OF SOLICITATION PROCESS. WE HAVE DEALT WITH RADIOLOGY FOR QUITE SOMETIME. WE HAD PROBLEMS DURING KING-DREW WITH THE RADIOLOGY DEPARTMENT, NUMEROUS QUESTIONS WHEN ASKED. WHY WE ARE NOT, YOU KNOW, R.F.P. DONE AT THE TIME? WE ARE ALMOST THREE YEARS LATER AND WE STILL HAVE NOT ANY OTHER R.F.P., THE SAME PEOPLE WHO WERE AT THE TABLE. I'M SURE YOU SAW THE CITATION BY C.M.S. OF TWO OF THE HOSPITALS OF THE COUNTY, ONE BEING HARBOR U.C.L.A., WHICH IN THE ERRORS WERE PRETTY STEEP. MISLABELING TESTING RESULTS AND CAUSING PEOPLE TO HAVE THE WRONG SURGERY OR NOT HAVING THE SURGERY. AND U.S.C. ALSO MEDICAL CENTER IS HAVING SOME PROBLEMS. YOU KNOW, AS USUAL I AM CONCERNED WHAT IS GOING ON WITH D.H.S., AND WE STILL HAVE RIGHT NOW AN INTERIM DIRECTOR WHO IS CERTAINLY NOT QUALIFIED TO BE IN THAT POSITION. I THINK WE ARE STILL NOT TALKING ABOUT KING-DREW BEING REOPENED AT ANY TIME SOON. WE STILL DON'T HAVE A BUDGET. SO I WILL HOPE THAT -- 

SUP. MOLINA: WHAT ITEM IS THAT? 23. LET'S HOLD OFF ON THAT ITEM. 

SUP. BURKE, CHAIR: ALL RIGHT. WE'LL HOLD IT. SUPERVISOR MOLINA, YOU ACTUALLY WERE UP FIRST, SO WOULD YOU LIKE TO BRING IT UP? 

SUP. MOLINA: NO, I DON'T HAVE ANY INFORMATION. 

SUP. BURKE, CHAIR: OKAY. WELL S-1. IT'S 11 O'CLOCK. I'D LIKE TO CALL UP DEVALIS RUTLEDGE FROM THE DISTRICT ATTORNEY'S OFFICE. WOULD YOU PLEASE COME FORWARD? MR. RUTLEDGE? YES, HERE HE IS. 

DEVALIS RUTLEDGE: GOOD MORNING, CHAIR AND SUPERVISORS, LADIES AND GENTLEMEN, I'M DEVALIS RUTLEDGE, SPECIAL COUNSEL TO DISTRICT ATTORNEY STEVE COOLEY. YOU KNOW STEVE COOLEY TO BE A FAIR-MINDED PERSON WHO BELIEVES IN THE PROPORTIONALITY IN THE ADMINISTRATION OF CRIMINAL JUSTICE. BUT THIS PROPOSITION 5 IS JUST WAY OVER THE TOP. THIS IS THE WRONG WAY TO GO ABOUT WHAT THESE FOLKS ARE TRYING TO GO ABOUT. ALTHOUGH THERE ARE DOZENS, THIS IS A 60-PAGE INITIATIVE. IT'S TOUGH FOR EVEN A 30-YEAR LAWYER TO READ THROUGH THIS THING AND SORT IT OUT. BUT THERE ARE DOZENS OF OBJECTIONS TO IT. BUT IF I COULD JUST QUICKLY GIVE YOU A COUPLE TO GIVE YOU A FLAVOR OF THE OVER THE TOP NATURE OF THIS THING. ONE IS THIS: IMAGINE THIS. TWO CRIMINALS, TWO BURGLARS DECIDE TO BREAK INTO YOUR BUSINESS OFFICE AFTER HOURS. THEY GO IN THERE AND VANDALIZE THE PLACE, DO $100,000 WORTH OF DAMAGE. THEY STEAL THOUSANDS OF DOLLARS WORTH OF VALUABLES. WHILE THEY'RE AT IT THEY STEAL DOCUMENTATION THAT WILL ALLOW THEM TO STEAL YOUR IDENTITY AND YOUR CREDIT INFORMATION. THEY FIND THE SPARE KEYS TO YOUR CAR. THEY DRIVE BY YOUR HOUSE AND STEAL YOUR CAR BECAUSE THEY ALSO OPERATE AN IDENTITY THEFT RING, THEY OPERATE A CAR THEFT RING. WHEN THEY'RE EVENTUALLY CAUGHT, ONE OF THEM IS CLEAN AND SOBER, ONE OF THEM IS A METHAMPHETAMINE USER. THE ONE WHO IS CLEAN AND SOBER WILL GO OFF TO PRISON. THE ONE WHO IS CLEAN AND SOBER WILL GO OFF TO DRUG PROBATION. NOW, FIRST OF ALL, THIS IS JUST NOT FAIR THAT TWO PEOPLE WHO COMMIT EXACTLY THE SAME CRIME DON'T RECEIVE EQUAL JUSTICE UNDER THE LAW. BUT SECONDLY, THINK ABOUT WHAT AN INCENTIVE THIS CREATES FOR EVERYBODY IN THE CRIMINAL ELEMENT TO BECOME A DRUG ABUSER. BECAUSE THE WORD WILL GET AROUND IT DOESN'T TAKE A VERY SMART CRIMINAL TO FIGURE OUT "WAIT A MINUTE, IF I ALSO ABUSE DRUGS IN ADDITION TO WHATEVER CRIMES I'M COMMITTING HERE, ALL THESE QUALIFYING CRIMES, I WON'T FACE PRISON. I'LL JUST FACE DRUG PROBATION AND I'LL GO TO A REHABILITATION PROGRAM SOME PLACE." THIS INCENTIVIZES GREATER DRUG ABUSE. THIS IS EXACTLY OPPOSITE WHAT WE WANT TO BE TRYING TO DO. ONE OTHER EXAMPLE. THERE ARE ALL KINDS OF MANDATES IN HERE AGAINST THE COUNTIES THERE'S JUST NO FUNDING FOR. THERE IS NO FUNDING FOR DRUG TESTING, FOR EXAMPLE. AND A DRUG PROGRAM WITHOUT TESTING IS JUST A JOKE. THERE IS NO FUNDING FOR THAT. THERE IS NO FUNDING FOR THE TRANSPORTATION AND CHILDCARE THAT THE COUNTY IS REQUIRED TO PROVIDE FOR PEOPLE WHILE THEY'RE GETTING THEIR DRUG TREATMENT. WE ARE REQUIRED TO PROVIDE THEM TRANSPORTATION TO AND FROM AND CHILDCARE FOR MINOR CHILDREN WHILE THERE. AND THEN WE ASSUME THE RISKS OF LIABILITY FOR ANYTHING THAT GOES WRONG WHILE THOSE CHILDREN ARE IN OUR CARE? THE INSURANCE, THE STAFF, THE INFRASTRUCTURE. THERE'S NO PROVISION FOR FUNDING FOR ANY OF THIS, WHICH COULD EASILY RUN US WITH 50,000 OF THESE CASES A YEAR, WHICH IS WHAT'S PROJECTED, THIS COULD EASILY RUN US HUNDREDS OF MILLIONS OF DOLLARS. THERE'S NO FUNDING FOR THIS. THOSE ARE JUST TWO EXAMPLES OF WHY THE DISTRICT ATTORNEY, EVEN THOUGH HE IS A STRONG PROPONENT OF REHABILITATION OF PEOPLE WHO HAVE A PROBLEM THAT CAN BE REHABILITATED, THIS IS DISPROPORTIONAL JUSTICE. IT'S MASSIVE UNFUNDED MANDATES AGAINST THE COUNTY. SO WE'LL ASK YOU TO HONOR THE RECOMMENDATION OF YOUR CRIMINAL JUSTICE COORDINATING COMMITTEE AND VOTE TO OPPOSE PROPOSITION 5, PLEASE. THANK YOU. 

SUP. BURKE, CHAIR: THANK YOU. SHERIFF BACA? 

SHERIFF LEE BACA: YES, GOOD MORNING AND THANK YOU. YOU KNOW, THIS IS A VERY DIFFICULT ISSUE, OBVIOUSLY, BECAUSE SO MANY PEOPLE ARE AFFECTED BY DRUGS. AND IT'S A TRAGEDY IN EVERY SENSE OF THE WORD. WHERE I FIT IN ON THIS IS THAT AS THE VICE CHAIR OF THE COUNTY CRIMINAL JUSTICE COORDINATING COUNCIL, ALONG WITH A GREAT BODY OF THINKERS WHO HAVE RESPONSIBILITIES FOR PUBLIC POLICY, AND YOUR BOARD HERE IS AN IMPORTANT PART OF THAT RESPONSIBILITY, AND WHAT YOU SAY MATTERS. BUT WHERE WE HAVE TO LOOK AT OUR HISTORY WITH PROP 36, AND I BELIEVE THAT WE'VE DONE BETTER THAN ANY COUNTY IN CALIFORNIA WHEN IT COMES TO PROP 36. WE HAVE ABOUT A 20 PERCENT SUCCESS RATE. WE HAVE THE SUPERIOR COURT OVERSEEING A LOT OF WHAT'S GOING ON. BUT PUBLIC HEALTH IS COMMITTED. I HAVE THE LARGEST RECOVERY CENTER IN JAILS IN THE UNITED STATES. WE HAVE COUNTLESS EXAMPLES OF PEOPLE IN THE COUNTY JAIL THAT NEED DRUG RECOVERY. AND MY BELIEF PHILOSOPHICALLY IS THAT WITHOUT RECOVERY OPPORTUNITY IN JAIL, THAT PERSON'S COMING BACK OUT JUST AS ADDICTED AS THEY WERE WHEN THEY CAME IN. [APPLAUSE.] NOW, THE DIFFICULTY HERE -- 

SUP. BURKE, CHAIR: WE'RE GOING TO ASK YOU NOT TO CLAP. IF YOU ARE SUPPORTING SOMETHING, IF YOU HAVE ANY COMMENT AT ALL, JUST DO IT LIKE THIS. THANK YOU. 

SHERIFF LEE BACA: NOW THE DIFFICULTY WITH PROP 5, AND THOSE OF US WHO ARE THE PROVIDERS, AND I HAVE L.A. IMPACT INSIDE THE JAILS AND THEY KNOW WHAT THEY'RE DOING. THOSE OF US THAT ARE THE PROVIDERS, THOSE OF US THAT WANT TO HELP PEOPLE WHO ARE ADDICTED TO DRUGS, ONE THING I CAN SAY FOR SURE IN THE WHOLE WORLD OF RECOVERY, I'VE BEEN IN IT FOR 10 YEARS HARD NOW, IS THERE'S NO GUARANTEES. AND BECAUSE OF THAT, WHEN THERE'S A BROADER SWEEPING REALITY THAT PEOPLE WHO ARE TAKING DRUGS ARE SO PRECARIOUSLY AT RISK, THAT EVEN WITH THIS INITIATIVE, WITH THE HUNDREDS OF MILLIONS OF DOLLARS IT WILL REQUIRE, THERE IS NO GUARANTEE. AND I TAKE EXCEPTION TO PUBLIC POLICY BEING DONE WITHOUT THOSE OF US WHO ARE MOST RESPONSIBLE FOR THE OUTGROWTH OF WHAT'S THE DARK SIDE OF DRUG USAGE. AND I'LL TELL YOU THE REAL THING THAT WE NEED TO SOLVE THIS, IF WE'RE EVER GOING TO GET TO THE RIGHT PLACE AS A NATION, IS THAT WE HAVE A SERIOUS EFFORT WITH OUR YOUNG PEOPLE AND OUR OLDER PEOPLE THAT DRUGS ARE SOMETHING THEY CAN LIVE WITHOUT. THAT THE IDEA THAT WE HAVE CITIZENS USING DRUGS IS AN AMAZING BREACH OF HUMAN RESPONSIBILITY FOR YOURSELF. AND WHEN THOSE OF US THAT ARE NOT DRUG USERS ARE SAYING "WELL I'M GOING TO BE MORE RESPONSIBLE FOR YOU, THE DRUG USER, THAN YOU'RE WILLING TO BE FOR YOURSELF" WE HAVE A SERIOUS MEDICAL PROBLEM. WE HAVE A SERIOUS HUMAN PROBLEM. AND TO SHOW YOU HOW BAD THIS PROBLEM IS, UP IN THE SAN GABRIEL MOUNTAINS ON FRIDAY, I WENT UP THERE AND HELPED ERADICATE AND PULL 70,000 MARIJUANA PLANTS OUT OF THE SAN GABRIEL MOUNTAINS. HAPPENED TO THE GREEN PHILOSOPHY? THE GREEN PHILOSOPHY IS THAT YOU DON'T CONTAMINATE THE NATURAL HABITAT WITH GROWING MARIJUANA PLANTS. YOU DON'T CONTAMINATE THE BODY WITH TAKING MARIJUANA UNLESS YOU HAVE SOME MEDICAL NEED. YOU HAVE TO HAVE A REALITY IF WE'RE GOING TO BE A GREEN STATE OR A GREEN NATION THAT PEOPLE TAKING DRUGS ARE NOT GREEN AT ALL. THEY'RE VIRTUALLY OUT OF CONTROL. AND IT'S SAD BECAUSE THEY DON'T KNOW HOW TO BRING THEMSELVES BACK IN CONTROL. AND SO WE'RE NOW SAYING SPEND $500 MILLION TO HELP BRING PEOPLE BACK IN CONTROL AND THERE'S NO GUARANTEE. AND SO THE FRUSTRATION IS THAT THE INDIVIDUAL IS ON SUCH A PRECARIOUS SPIRAL AS A DRUG USER THAT THEY THEMSELVES DON'T KNOW THE WAY OUT. AND BECAUSE THEY DON'T KNOW THE WAY OUT, IT'S PRESUMPTIVE THAT SPENDING ALL THIS MONEY IS GOING TO GET THEM OUT OF THIS DRUG PROBLEM. AND MY BELIEF IS THAT WE'RE STILL NOT THERE TO GO THIS FAR. WE REALLY NEED TO THINK ABOUT THIS AND RECALIBRATE A BETTER ANSWER. THAT'S ALL WHY I'M HERE POSING THIS BECAUSE I WANT TO BE A PART OF THE BETTER ANSWER. I DON'T WANT TO HAVE SOMEONE OVER HERE THAT'S PLANNING ALL THIS THAT DOESN'T ASK LAW ENFORCEMENT ONE QUESTION ABOUT WHAT IS IT GOING TO MEAN TO YOU? WHAT IS IT GOING TO MEAN TO PUBLIC SAFETY IF WE GO ON THIS PATH? WE HAVE NOT SUCCEEDED IN THE WAR AGAINST DRUGS. WE HAVE NOT SUCCEEDED IN THE CONSUMPTION OF DRUGS. AND THIS IS A TRAGEDY. BUT IT'S A HUMAN TRAGEDY WITH NO GUARANTEES. AND WE NEED GUARANTEES. I'M OPPOSED TO THIS. THANK YOU. 

SUP. BURKE, CHAIR: ALL RIGHT. THANK YOU. WE HAVE A NUMBER OF PEOPLE WHO HAVE ASKED TO SPEAK IN OPPOSITION TO THE PRESENT POSITION THAT'S RECOMMENDED. BARBARA SPILLE? RICHARD ALSOP, WOULD YOU PLEASE COME FORWARD? GABRIEL BOWDEN. PLEASE COME FORWARD. AND THEN I'LL BE CALLING MARGARET DOOLEY-SAMMUL. PLEASE STATE YOUR NAME. 

RICHARD ALSOP: HI, I'M RICHARD ALSOP. GOOD MORNING, BOARD. I WORK IN SOUTH LOS ANGELES. I'M A SUBSTANCE ABUSE COUNSELOR. I'VE WORKED IN THE TRENCHES FOR 10 YEARS IN EVERY PART OF OUR BEAUTIFUL CITY THAT SOME PEOPLE DON'T CONSIDER SO BEAUTIFUL. I DEAL WITH A LOT OF HARDCORE CASES. I ALSO WORK IN THE MENTAL HEALTH FIELD. AND I'VE HAD THE EXPERIENCE TO WATCH OUR SYSTEM IN FULL SWING FROM BEING DOWN IN THE TRENCHES. I HAVE READ THE INITIATIVE. I FIRMLY SUPPORT THE INITIATIVE. I THINK THAT IT'S A WIN/WIN SITUATION ON A LOT OF LEVELS FOR THE STATE, THE COUNTY, AND OF COURSE THE PEOPLE THAT ARE IN MOST NEED OF THE HELP. THERE'S A LOT OF THINGS IN THE INITIATIVE THAT PEOPLE WILL FIND AND SAY THAT MAYBE NEEDS SOME ATTENTION, MAYBE NEEDS SOME WORK, THAT'S TRUE WITH MOST INITIATIVES. YOU'RE GOING TO FIND THAT IN EVERY PART OF LIFE. AND I JUST THINK THAT THIS IS A REALLY GOOD -- THIS PROP 5 IS A REALLY GOOD THING. I THINK IT'LL WORK FOR MOST OF THE PEOPLE THAT I DEAL WITH ON A DAILY BASIS AND SUPPORT THEM THROUGH THEIR JOURNEY TO TURNING THEIR LIVES AROUND AND BEING A MORE PRODUCTIVE MEMBER OF SOCIETY. THANK YOU. 

SUP. BURKE, CHAIR: STATE YOUR NAME, PLEASE. 

BARBARA SPILLE: BARBARA SPILLE. 

SUP. BURKE, CHAIR: AND WOULD MARGARET DOOLEY-SAMMUL COME FORWARD? YES, PLEASE STATE YOUR NAME. 

BARBARA SPILLE: BOARD OF SUPERVISORS, I'M A PERSON IN LONG-TERM RECOVERY. I AM ONE OF THESE PEOPLE THAT THE OPPOSITION IS AGAINST. FROM A VERY EARLY AGE, I USED DRUG FROM 13, GOING INTO YOUTH AUTHORITY, STATE PRISON, BACK AND FORTH, IN AND OUT OF THE COUNTY JAILS. I CALLED FOR MONTHS TRYING TO GET IN TREATMENT, KNOWING I DIDN'T WANT TO DO THAT. I DIDN'T KNOW HOW TO DO ANYTHING BUT USE. I HAVE BEEN CLEAN 20 YEARS ON OCTOBER 28TH BUT SOMEONE NEEDED TO TAKE MY HAND AND SHOW ME. I AM NO LONGER A BURDEN ON THE STATE, WHERE BEFORE I WAS USING THE EMERGENCY ROOMS, I WAS UNEMPLOYABLE. I WAS A BURDEN. I WAS JUST A BURDEN ALL THE WAY AROUND. TODAY I'M A GOOD NEIGHBOR. I'M A GOOD CITIZEN. I'M EMPLOYED. I PAY MY TAXES. AND I'LL HELP YOU ACROSS THE STREET IF YOU NEED IT. BUT I COULDN'T HAVE DONE IT WITHOUT A PROGRAM. AND I THINK AT THIS TIME THE SUPERVISORS NEED TO HEAR MORE FROM BOTH SIDES BEFORE MAKING A DECISION, THANK YOU. 

SUP. BURKE, CHAIR: THANK YOU. WOULD ITAI DANOVITCH AND VINCENT SCRIBNER COME FORWARD. PLEASE STATE YOUR NAME. 

GABRIEL BOWDEN: MY NAME IS GABRIEL BOWDEN AND I WOULD JUST LIKE TO THANK THE BOARD FOR SUPPORTING PROPOSITION 36 THAT WAS JUST THE EMBRYO OF THE NORA PROPOSITION 5. AND YOU GAVE US THIS IN APRIL OF 2007 WHERE IT READS "WHEREAS, OVER 18,000 RESIDENTS OF THE COUNTY OF LOS ANGELES SUCCESSFULLY COMPLETED TREATMENT AND ARE ON THE ROAD TO LONG-TERM RECOVERY THANKS TO SUBSTANCE ABUSE TREATMENT THEY RECEIVED UNDER PROPOSITION 36, THE SIX-YEAR-OLD VOTER-ENACTED TREATMENT INSTEAD OF INCARCERATION LAW AND WHEREAS GRADUATES OF PROPOSITION 36 ARE PROOF THAT ADDICTION IS TREATABLE AND THAT THE LONG-TERM RECOVERY IS ACHIEVABLE. AND WHEREAS RECOVERY FROM DRUG AND ALCOHOL ADDICTION RESTORES HOPE, REBUILDS LIVES AND STRENGTHENS FAMILIES. AND BY CHOOSING TREATMENT INSTEAD OF JAIL, PROPOSITION 36 GRADUATES HAVE HELPED SAVE TAXPAYERS AT LEAST $850 MILLION IN JUST FIVE YEARS. AND WE WOULD JUST LIKE TO THANK THE BOARD OF SUPERVISORS OF THE LOS ANGELES, STATE OF CALIFORNIA, THIS IS WHAT WAS GIVEN. AND WE JUST ASK THAT YOU DO NOT OPPOSE PROPOSITION 5. THANK YOU. 

SUP. BURKE, CHAIR: THANK YOU. PLEASE STATE YOUR NAME. AND WOULD CHALON SMITH ALSO COME FORWARD? 

MARGARET DOOLEY-SAMMUL: MY NAME IS MARGARET DOOLEY-SAMMUL. I AM WITH THE DRUG POLICY ALLIANCE NETWORK, THE SPONSOR OF BOTH PROPOSITION 36 IN 2000 AND PROPOSITION 5 ON THE NOVEMBER BALLOT THIS YEAR. I THINK IT'S MORE IMPORTANT I KNOW FOR YOU TO HEAR FROM GREATER CONSTITUENCIES IN LOS ANGELES COUNTY, AND I'M GLAD THEY'RE HERE TODAY, BUT I DO IMPLORE YOU AS A REPRESENTATIVE OF THE CAMPAIGN THAT BEFORE YOU MAKE A DECISION ONE WAY OR ANOTHER, YOU LISTEN TO BOTH SIDES. THERE ARE MANY DIFFERENT PERSPECTIVES ON THIS QUITE LENGTHY INITIATIVE. BUT I WOULD LIKE TO SAY THAT THIS INITIATIVE, THE NONVIOLENT OFFENDER REHABILITATION ACT, IS BASED ON DECADES OF RESEARCH AND RECOMMENDATIONS THAT POLICYMAKERS HAVE MADE IN REPORT AFTER REPORT. WE DID NOT GO TO THE INITIATIVE PROCESS LIGHTLY. THOSE REPORTS AND THOSE RECOMMENDATIONS ARE STACKED UP ON OUR LEGISLATORS' DESKS IN SACRAMENTO. NORA BRINGS THE BEST OF THOSE POLICIES INTO A REFORM PACKAGE THAT PROMISES TO EXPAND ACCESS TO DRUG TREATMENT AND ADDRESS OUR STATE'S CRITICAL PRISON OVERCROWDING CRISIS. IT'S SOMETHING THAT THE LEGISLATURE HAS NOT BEEN ABLE TO DO THAT THE NONVIOLENT OFFENDER REHABILITATION ACT GIVES THE VOTERS THE RIGHT TO DO. I WOULD LIKE TO MAKE ONE IMPORTANT CORRECTION TO THE ANALYSIS THAT WAS PRESENTED TO THE BOARD PREVIOUSLY, AND THAT IS THAT THERE IS NO "GET OUT OF JAIL FREE CARD" IN PROP 5. THERE IS NO ADDITIONAL -- EVERY NONVIOLENT OFFENDER IS GOING TO SERVE THEIR TIME THAT THEY'RE SENTENCED TO. THERE IS NO MAGIC PHRASE THAT ONE CAN UTTER IN A COURTROOM TO ESCAPE ACCOUNTABILITY. IN FACT, PROP 5 INCREASES ACCOUNTABILITY. IT IS THOSE IMPROVEMENTS AND EXPANSION OF PROP 36 THAT A VARIETY OF STAKEHOLDERS, INCLUDING THOSE WHO SPOKE EARLIER IN OPPOSITION TO PROP 5 HAVE MADE OVER THE EIGHT YEARS OF PROPOSITION 36. PROP 5 IS THAT OPPORTUNITY FOR IMPROVEMENT, FOR EXPANSION. AND I ASK THAT THIS BOARD CONSIDER IT VERY CAREFULLY AND ALLOW BOTH SIDES OF THE DEBATE TO BE HEARD PUBLICLY BEFORE YOU MAKE YOUR DECISION. THANK YOU. 

SUP. BURKE, CHAIR: THANK YOU. AND WOULD LISA LEON PLEASE COME FORWARD. PLEASE STATE YOUR NAME. 

DR. ITAI DANOVITCH: DR. ITAI DANOVITCH. GOOD MORNING. IT'S A PLEASURE AND HONOR TO BE ABLE TO ADDRESS THE BOARD ON THIS MORNING. I'M THE DIRECTOR OF ADDICTION PSYCHIATRY CLINICAL SERVICES AT CEDAR SINAI. IN ADDITION TO MY WORK AT CEDAR SINAI, LAST YEAR I SPENT EVERY WEDNESDAY PROVIDING MENTAL HEALTH SERVICES AT TWIN TOWERS IN MENS' CENTRAL JAIL JUST AROUND THE CORNER FROM HERE. AND I'D JUST LIKE TO MAKE A FEW POINTS. FIRST, IN JAIL I WORKED WITH MANY INMATES WHO WERE INCARCERATED FOR NONVIOLENT DRUG OFFENSES. I SAW THEM COME IN AND GO OUT THROUGH A REVOLVING DOOR. MY PERSONAL EXPERIENCE WAS CONSISTENT WITH WHAT WE KNOW FROM THE LITERATURE, WHICH IS THAT INCARCERATION ALONE IS SIMPLY NOT AN EFFECTIVE TREATMENT FOR DRUG ADDICTION. WITH THE CURRENT RESOURCES THAT WE HAVE AT HAND, AND DESPITE MY OWN EFFORTS AND MY COLLEAGUES' EFFORTS, WORKING WITHIN THE CRIMINAL JUSTICE SYSTEM, EFFECTIVE DRUG TREATMENT IS PROHIBITIVELY DIFFICULT TO PROVIDE IN JAILS AND IN PRISONS. SECOND, WE KNOW THAT DRUG ADDICTION IS A TREATABLE CONDITION. THERE ARE NO GUARANTEES. BUT THERE ARE NO GUARANTEES FOR HYPERTENSION, NOT FOR HEART ATTACKS, NOT FOR MANY MEDICAL CONDITIONS. AND THERE ARE NO GUARANTEES FOR DRUG ADDICTION, EITHER, BUT THERE ARE MANY, MANY INTERVENTIONS THAT HAVE EXCELLENT EVIDENCE. FINALLY, OF GREATEST CONCERN IS THE ENORMITY OF DRUG PROBLEMS AND DRUG USE THAT WE SEE AMONG OUR YOUTH. CURRENTLY WE'RE ABLE TO IDENTIFY, SCREEN FOR, RECOGNIZE A LOT OF THESE PROBLEMS BUT WE SIMPLY DO NOT HAVE THE RESOURCES TO TREAT OUR YOUTH. PROPOSITION 5 WOULD FUND THE CREATION OF A SYSTEM OF CARE FOR YOUNG PEOPLE THAT WE JUST DON'T HAVE NOW. IT WOULD ALSO PROVIDE DESPERATELY NEEDED FUNDING FOR MENTAL HEALTH TREATMENT TO PEOPLE SUFFERING FROM ADDICTION, BOTH BEHIND BARS AND IN THE COMMUNITY. SO AS A PHYSICIAN CONCERNED ABOUT THE LACK OF ADDICTION TREATMENT RESOURCES IN L.A. COUNTY, I ASK THE BOARD NOT TO OPPOSE PROPOSITION 5 WITHOUT CONSIDERING THE ENORMITY OF THE BENEFIT THAT IT WOULD PROVIDE TO OUR COUNTY. THANK YOU. 

SUP. BURKE, CHAIR: THANK YOU. WOULD YOU STATE YOUR NAME, PLEASE? 

VINCENT SCRIBNER: HELLO, BOARD OF SUPERVISORS. MY NAME'S VINCENT SCRIBNER, I WORK FOR A TREATMENT PROVIDER IN SPA ONE OUT IN THE ANTELOPE VALLEY. THE ONE THING I CAN SAY FROM MY EXPERIENCE WORKING IN THE FIELD IS THAT THERE'S NOT ENOUGH RESOURCES. AND ONE PROGRAM THAT MET WITH A HIGH DEGREE OF SUCCESS WHEN YOU'RE DEALING WITH ADDICTION, WHICH THERE ARE NO MAGIC ANSWERS TO, WAS PROPOSITION 36. HAVING WORKED WITH PROPOSITION 36 SINCE ITS INCEPTION, THERE'S DEFINITELY SOME THINGS ABOUT IT THAT COULD HAVE BEEN IMPROVED. HOWEVER, THE OVERALL IMPACT ON MY COMMUNITY WAS POSITIVE. THE PEOPLE THAT WROTE NORA, WHICH WERE HIGHLY MORE EDUCATED THAN MYSELF, TOOK ALL OF THAT INTO CONSIDERATION AND TRIED TO FIX THE PARTS OF IT THAT DIDN'T WORK AS WELL. AND FROM EVERYTHING THAT I'VE READ, I KNOW AT LEAST IN MY COMMUNITY, IT WOULD GIVE US THE RESOURCES TO TREAT A POPULATION THAT STANDS IN LINE TO GET IN MY DOORS. I BELIEVE THAT BEFORE YOU GUYS MAKE A DECISION, I WOULD ASK THAT YOU PLEASE STUDY THE LITERATURE AND ALL THE PEOPLE THAT WEIGH IN ON IT BECAUSE IT IS A VERY WEIGHTY ISSUE. BUT THE BOTTOM LINE IS THAT THERE'S A LOT OF PEOPLE THAT ARE IN PRISON SIMPLY FOR DRUG USE. AND WHAT HAPPENS IS WE SEND THEM BACK TO PRISON BECAUSE THEY USE DRUGS AGAIN. AND THEN WE CUT THEM OUT AND THEY USE DRUGS AGAIN AND GO BACK AND FORTH. AND THAT'S NOT A SOLUTION TO THE PROBLEM. THERE IS SOME TREATMENT INSIDE. HOWEVER, NORA EXPANDS THAT TREATMENT EXPONENTIALLY AND MAKES IT A PRIORITY TO TREAT PEOPLE WITH A DRUG PROBLEM FOR THAT PROBLEM THEY HAVE. SO I URGE YOU TO SUPPORT NORA. THANK YOU. 

CHALON SMITH: HELLO. MY NAME IS CHALON SMITH, AND THAT'S SPELLED C-H-A-L-O-N. AND I'M HERE IN REGARDS TO PROPOSITION 5 BECAUSE IF IT WAS NOT FOR SUBSTANCE ABUSE TREATMENT AND PROPOSITION 36 AND OTHER TREATMENT INITIATIVES OUT THERE, I WOULD NOT BE SOBER TODAY. I'M A TWO-STRIKER. I WAS ADDICTED TO CRACK COCAINE. AND IF IT WASN'T FOR THE FACT THAT I TOOK SUBSTANCE ABUSE TREATMENT INTO MY LIFE, I DON'T KNOW WHERE I WOULD BE. I WOULD PROBABLY BE DOING 25 TO LIFE RIGHT NOW. I AM NOW AM A SUBSTANCE ABUSE COUNSELOR AND I WORK IN THE FIELD AND I WATCH MILLIONS OF WOMEN AND THEIR FAMILIES GET RECOVERY AND I WATCH THEM COME THROUGH TREATMENT AND GET SOBER AND STAY OUT OF JAIL AND STAY OUT OF SLIPPERY PLACES. BUT IF IT'S NOT FOR THE FACT THAT THEY RECEIVED TREATMENT THAT THEY PROBABLY WOULD GO BACK, AS WELL. PLEASE, PLEASE VOTE NO ON PROPOSITION 5, THANK YOU. I MEAN YES, I'M SORRY. [LAUGHTER.] 

LISA LEON: HI, MY NAME IS LISA LEON, AND I'M A COMMUNITY ORGANIZER FOR AN ORGANIZATION, A RE-ENTRY PROJECT CALLED A NEW WAY OF LIFE. PRIOR TO THAT, FIVE YEARS AGO I AM A FORMER RESIDENT OF A NEW WAY OF LIFE. I STRUGGLED WITH A CONDITION, A DRUG AND ALCOHOL ABUSE, FOR MANY YEARS OF MY LIFE. AND I REMEMBER VERY WELL JUST LIKE IT WAS YESTERDAY THOSE TIMES WHEN I WISHED I HAD HAD SOMEWHERE TO GO. THE CONDITION KEPT ME A PRISONER WITHIN MYSELF. AND IF IT WASN'T FOR THE OPPORTUNITY TO GO INTO TREATMENT, THEN I PROBABLY WOULD HAVE DIED OUT THERE ON THE STREETS. I AM NOW WORKING WITH A NEW WAY OF LIFE. AND I AM ALSO A STUDENT AT A UNIVERSITY STUDYING PSYCHOLOGY. BUT I WOULD NOT HAVE BEEN ABLE TO HAVE THOSE OPPORTUNITIES OR EVEN SEEK THE GOALS THAT I HAVE SET FOR MY LIFE ALONG WITH THE SUPPORT AND THE STRUCTURE AND THE GOOD PROGRAM THAT IS STILL SUPPORTING ME. I WOULDN'T HAVE BEEN ABLE TO SET GOALS. I WOULDN'T HAVE BEEN ABLE TO SEE THAT THEY WERE POSSIBLE. REHABILITATION IS SO IMPORTANT FOR PEOPLE THAT ARE ON DRUGS AND ALCOHOL BECAUSE MOST CASES, ONCE YOU GET STARTED USING DRUGS AND ALCOHOL IT'S NOT AN EASY THING TO STOP DOING ON YOUR OWN. SO I'M URGING YOU NOT TO OPPOSE THIS PROPOSITION AND TO SEEK THE BENEFITS OF THIS PROGRAM IN REGARD TO THE PEOPLE AND TO THE BUDGET, AS WELL. THANK YOU. 

SUP. BURKE, CHAIR: JUDGE TYNAN. AND HE'S BEEN I GUESS THE GREATEST PROPONENT OF DRUG COURT. 

JUDGE MICHAEL TYNAN: I'M HERE AS A REPRESENTATIVE OF THE L.A. SUPERIOR COURT AND I'M HERE TO GIVE YOU SOME FACTS, I HOPE. I AM IN CHARGE OF DRUG COURTS FOR THE COUNTY'S COURT SYSTEM, PROP 36 AS WELL AS MY OWN COURT, THE SENTENCE OFFENDER DRUG COURT. WE BELIEVE DRUG COURTS WORK. WE BELIEVE THAT PROP 36 CAN WORK FOR A CERTAIN CLASS OF PEOPLE. BUT FOR THE PEOPLE THAT HAVE LONG CRIMINAL RECORDS, WHO ARE THE ONES IDEAL WITH, IT DOESN'T WORK AT ALL. A LOT OF MY FOLKS THAT I SEE ARE FALLOFFS FROM PROP 36. I THINK YOU'VE HEARD FROM THE DISTRICT ATTORNEY AND YOU'VE HEARD FROM THE SHERIFF THIS MORNING, I THINK THEY KNOW. I KNOW WHAT THEY SAID. THIS WILL IMPACT THE COURTS, I THINK, TERRIBLY. IT'S GOING TO COST US ANOTHER $63 MILLION A YEAR FOR THE ADDITIONAL PROCEDURES THAT WE'RE GOING TO HAVE TO GO THROUGH. PROP 5 IS SPECIFICALLY -- IT ELIMINATES MONEY. IT GIVES NO MONEY FOR TESTING. EVERYBODY IN THE BUSINESS, THE TREATMENT BUSINESS, KNOWS THAT TESTING IS ABSOLUTELY CRITICAL TO MAKE SURE THAT THESE FOLKS ARE COMPLYING WITH THEIR ORDERS. WE TEST MICHAEL PHELPS EVERY TIME HE WINS A RACE, HE GETS A GOLD MEDAL. HE'S A HERO. I THINK WE CAN ALSO TEST, WE SHOULD TEST PEOPLE THAT ARE UNDERGOING TREATMENT FOR A HORRIBLE, HORRIBLE ADDICTION. BUT WHAT I SUSPECT HAS NOT YET BEEN COVERED. YOU KNOW ABOUT TRACK 1, 2 AND 3. BUT TRACK 3, WHICH IS SUPPOSED TO BE THE DRUG COURT TRACK, IF THE DEFENDANT VIOLATES OUT OF TRACK 2 AND REFUSES TO PARTICIPATE IN TRACK 3, THE MAXIMUM PENALTY THE COURT MAY IMPOSE IS ONE YEAR IN JAIL. THAT'S FOR A TRACK 2 VIOLATION. THAT EFFECTIVELY MAKES ALL FELONY DRUG POSSESSIONS MISDEMEANORS, BECAUSE THEY'RE ONLY GETTING A YEAR IN THE COUNTY JAIL. THAT'S SOMETHING THAT OUGHT TO BE REALLY THOUGHT ABOUT BY THE PUBLIC WHEN THEY VOTE ON THIS. BUT THAT IS IN THIS BILL. BUT IF A PERSON ELECTS TO GO TO TRACK 3 AND VIOLATES OUT, HE CAN BE SENTENCED AS IF HE WERE ON A REGULAR CASE. AND A LOT OF THESE PEOPLE HAVE STRIKES. MANY, MANY MORE OF THESE PEOPLE HAVE ONE YEAR PRIORS. ANYBODY THAT IS IN THAT POSITION, ANYBODY THAT KNOWS HE MIGHT GET A PRISON COMMITMENT IF HE DELIBERATELY FAILS PROP 5 IS NOT GOING TO OPT FOR PROP 3. IT'S GONE. DRUG COURTS EFFECTIVELY ARE GONE. BESIDES THE COSTS OF IT, YOU ARE GOING TO ELIMINATE THE MOST EFFECTIVE PROGRAM WE HAVE FOR DRUG ADDICTION. I FEEL SORRY FOR THE FOLKS THAT COME IN FRONT OF ME. I DO EVERYTHING I CAN TO HELP THEM. BUT I THINK THIS IS A FRAUD AND A FARCE. HAVING SAID THAT, YOU CAN MAKE YOUR OWN CALL ON WHICH WAY I'D ASK YOU TO VOTE. BUT GOOD LUCK. THANK YOU. 

SUP. BURKE, CHAIR: THANK YOU. I THINK THE C.E.O. HAD MADE AN ANALYSIS IN TERMS OF THE COUNTY'S COSTS AND EFFECT ON PROGRAMS. 

SHARON HARPER: CORRECT, WE DID, SUPERVISOR. AND BASED ON THE RECOMMENDATIONS AND THE REVIEWS FROM THE VARIOUS AFFECTED DEPARTMENTS, THE CONSENSUS OF -- THAT SINCE THERE IS NO MONEY BEHIND IT, IT'S GOING TO COST AN ESTIMATED $460 MILLION WITH NO GUARANTEE THAT THE STATE WILL BE PROVIDING FUNDING. IT MAY IMPACT EXISTING PROGRAMS. AND THE EFFECTIVENESS OF THIS PROPOSITION IS AT QUESTION. WE WERE RECOMMENDING OPPOSITION TO PROPOSITION 5. 

SUP. BURKE, CHAIR: ALL RIGHT. JOSE ESQUEDA JUST CAME IN. WOULD YOU JUST CAME IN, WOULD YOU LIKE TO COME FORWARD? AND YOU WILL BE THE LAST SPEAKER BECAUSE WE HAVE CALLED EVERYONE UP TO THIS POINT. 

JOSE ESQUEDA: THANK YOU. MY NAME IS JOSE ESQUEDA. I'M A 20-YEAR-OLD -- ACTUALLY SPENDING 20 YEARS IN THE FIELD WORKING WITH YOUTH IN THE SUBSTANCE ABUSE FIELD. LISTENING TO SAYING THAT THERE IS NO GUARANTEES THAT OUR CONSTITUENTS WILL STAY OUT OF DRUGS, THERE IS NO GUARANTEES IN LIFE. THERE IS NO GUARANTEE THAT I WILL STAY ALIVE TOMORROW. ALL I KNOW IS THAT OUR YOUTH ARE USING AND ABUSING DRUGS AT A YOUNGER AGE. WE'RE SEEING IT IN JUNIOR HIGH AS EARLY AS 11 TO 12 YEAR OLDS. AND IT'S JUST IMPACTING OUR WHOLE COMMUNITIES. IT'S NOT AN ISSUE TO TAKE LIGHTLY. I URGE THE BOARD OF SUPERVISORS TO CONSIDER SUPPORTING NORA. IT IS A MEASURE THAT ALLOWS FOR ME TO CONTINUE TO DO MY WORK WITH THE YOUTH WE CONTINUOUSLY WORK FOR. WE WORK FOR THEM TO BETTER THEIR LIVES, TO CONTINUE TO GRADUATE JUNIOR HIGH AND HIGH SCHOOL. SO I URGE AND I AM IN SUPPORT OF NORA. 

SUP. BURKE, CHAIR: THANK YOU VERY MUCH. ARE THERE QUESTIONS? SUPERVISOR KNABE, WERE YOU? 

SUP. KNABE: I JUST -- WELL I THINK THE INTENTIONS IN MANY CASES OF THESE PROPOSITIONS ARE WELL AND GOOD, THE GOVERNMENT BY INITIATIVE HAS NOT BEEN SUCCESSFUL OVER THE YEARS, PARTICULARLY AS IT IMPACTS THOSE OF US IN COUNTY GOVERNMENTS, WHETHER IT BE LOS ANGELES COUNTY AS THE LARGEST COUNTY IN AMERICA OR SMALLER COUNTIES ON OTHER SERVICES. ONE OF THE THINGS AS IT RELATED TO PROP 36 WAS OUR DIFFICULTY IN TRYING TO SUPPORT THAT BECAUSE WE HAD A VERY SUCCESSFUL DRUG COURT AS THE JUDGE INDICATED. AND WE WERE LOOKING TO EXPAND THAT PROGRAM BUT BECAUSE OF THE OVERLAPPING IMPACTS OF PROP 36, THAT REALLY INHIBITED OUR ABILITY TO EXPAND OUR DRUG COURT PROGRAM, WHICH HAS BEEN EXTREMELY SUCCESSFUL. AND I KNOW THAT ALL OF US HAVE BEEN AT THE VARIOUS GRADUATION CEREMONIES IN THE VARIOUS COURTS. SO, AGAIN, WHILE THE INTENTIONS MAY BE GOOD, I THINK WE NEED TO CONTINUE TO MOVE FORWARD AND OPPOSE PROPOSITION 5 AND CONCENTRATE ON OUR DRUG COURT AND WHAT WE HAVE TO DO IS EXIST WITH PROP 36. 

SUP. BURKE, CHAIR: YES. 

SUP. ANTONOVICH: ALSO STATE THAT WHILE I SUPPORT MANDATORY TREATMENT REHABILITATION WHERE THERE IS ACCOUNTABILITY ON THE PART OF THE PARTICIPANT AND APPROPRIATE SANCTIONS FOR NONCOMPLIANCE. BUT AS STATED BY I BELIEVE EARLIER THE SHERIFF, THIS PROPOSITION 5 IS ESSENTIALLY A "GET OUT OF JAIL FREE CARD," AND WHAT'S WORSE, IT TAKES AWAY VITAL RESOURCES FROM OTHERS WHO ARE SERIOUS ABOUT REHABILITATION. AS THE JUDGE INDICATED, THE DRUG COURTS HAVE DONE A REMARKABLE JOB IN HELPING PEOPLE GET RID OF DRUG ADDICTION BY PUTTING THEM IN THAT TYPE OF PROGRAM. AND EXPANDING THE DRUG COURT IS ONE WAY OF DOING THE TREATMENT FOR THOSE WHO HAVE PROBLEMS WITH NARCOTICS. BUT THE PROPOSITION 5 IS THE WRONG APPROACH TO TAKE THAT -- TO HELP THOSE WHO ARE REALLY IN NEED AND NEED THAT ASSISTANCE. SO ACTUALLY ALL YOU'RE DOING IS SHORTENING PAROLE FOR THEM. METH DEALERS AND OTHER DRUG FELONS FROM THREE YEARS TO JUST SIX MONTHS. YOU'RE TALKING ABOUT A SHORT PERIOD OF, WHAT? 24 WEEKS. 

SUP. BURKE, CHAIR: ARE THERE OTHER COMMENTS? I'M REALLY CONCERNED ABOUT OUR PROGRAMS THAT HAVE BEEN SUCCESSFUL, AND DRUG COURT IS ONE OF THEM. AND WE HAVE SOME EXCELLENT PROGRAMS THAT WE HAVE TO MAINTAIN. AND I AM VERY CONCERNED THAT WE WOULD LOSE THE MONEY THAT WE NEED TO MAKE THESE PROGRAMS CONTINUE. I'M A REAL SUPPORTER OF OUR PROGRAMS THAT HAVE BEEN EFFECTIVE, AND DRUG COURT HAS BEEN PARTICULARLY EFFECTIVE. AND SO FOR THAT REASON, I AM NOT PREPARED AT THIS POINT TO LOOK AT NORA, WHICH IS SO COMPLEX. AND WHEN YOU START ANALYZING IT AND HOW THE FUNDS ARE GOING TO FLOW, IT CREATES MANY ISSUES THAT WE HAVE TO ADDRESS HERE IN THE COUNTY OF LOS ANGELES AND POTENTIAL LOSS OF SOME OF OUR FUNDS. SO FOR THAT REASON, I'M VERY CONCERNED ABOUT IT. YES, SUPERVISOR MOLINA? ALL RIGHT. IS THERE A MOTION? 

SUP. KNABE: I MOVE THE RECOMMENDATION. 

SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. WE HAVE ITEM -- MR. SACHS, WOULD YOU PLEASE COME FORWARD? YOU HAVE LIKE FIVE ITEMS. 

SUP. KNABE: MADAME CHAIR, WHILE HE'S COMING FORWARD I CAN DO MY ADJOURNMENT. I JUST HAVE ONE. 

SUP. BURKE, CHAIR: YES. 

SUP. KNABE: MADAME CHAIR, MEMBERS OF THE BOARD I MOVE TODAY WE ADJOURN IN MEMORY OF A GOOD FRIEND, HELEN O'NIELL, A 35-YEAR RESIDENT IN MARINA DEL REY AND A COMMUNITY VOLUNTEER WHO PASSED WAY FROM COMPLICATIONS OF A STROKE ON AUGUST 11TH. SHE WAS DEVOTED TO THREE THINGS: HER FAITH, HER FAMILY AND HER PASSION FOR THE COMMUNITIES OF MARINA DEL REY AND VENICE. SHE WAS A MEMBER OF THE BEL AIR PRESBYTERIAN CHURCH AND ATTENDED ON A REGULAR BASIS. SHE LOVED THE AREA OF MARINA DEL REY AND VENICE AND SHE WAS TRULY AN AMBASSADOR FOR BOTH AREAS. HELEN NOT ONLY PARTICIPATED IN COMMUNITY ACTIVITIES AND EVENTS, SHE WROTE A WEEKLY COLUMN FOR THE ARGONAUT NEWSPAPER FOR OVER 30 YEARS. SHE TOLD OF CHANGES IN THE MARINA BUSINESSES, THE UPCOMING EVENTS, THE OUTSTANDING ACCOMPLISHMENTS OF THE LIVES OF LOCAL RESIDENTS AS WELL AS DECISIONS BY THIS BOARD AS WELL AS THE BEACHES AND HARBORS. SO SHE IS SURVIVED BY HER SON, CRAIG, FOUR STEPCHILDREN AND FIVE GRANDCHILDREN. A GREAT LADY WHO HAS REALLY STRUGGLED WITH THAT STROKE FOR THE LAST FEW MONTHS. AND SHE'LL BE MISSED BY ALL. BUT OUR THOUGHTS AND PRAYERS ARE WITH HER SON, CRAIG, AND THE STEPCHILDREN AND GRANDCHILDREN, AS WELL, TOO. 

SUP. BURKE, CHAIR: SO ORDERED. 

SUP. KNABE: THANK YOU. 

SUP. BURKE, CHAIR: NO. 12, YOU HAVE 15, 19, 36, 37 AND 44. DO YOU WANT TO START WITH 12? 

ARNOLD SACHS: THANK YOU. YES, ARNOLD SACHS. THANK YOU VERY MUCH. ITEM 12 INVOLVES THE HOLLYWOOD ENTERTAINMENT DISTRICT AND BUSINESS IMPROVEMENT DISTRICT. IT'S NOT SO MUCH THE FUNDING THAT'S INVOLVED HERE. IT'S BASICALLY $10,577. IT WOULDN'T EVEN COVER THE S.E.I.U.'S $10,000 TAB AT THE GRAND HAVANA ROOM FOR CIGARS. IT'S THE IDEA THAT WHEN THIS ITEM APPEARED BEFORE THE CITY COUNCIL IN JUNE 27TH OF '08, ACCORDING TO THE RULES ESTABLISHED PURSUANT TO SECTION 6.600 THROUGH SECTION 6.620 OF CHAPTER 9 LOS ANGELES ADMINISTRATIVE CODE AND ARTICLE 13-D OF CALIFORNIA CONSTITUTION, THAT ALLOWS FOR THE CREATION OF A NONPROFIT TO OVERSEE THE BID. OR IN THE CITY OF L.A.'S CASE, NUMEROUS BIDS. AND THEN BUT WHAT IT DOESN'T ALLOW AND WHAT OCCURRED IN THIS PARTICULAR BIT OF LEGISLATION, WAS THAT THE NONPROFIT TURNS AROUND AND IS OVERSEEN BY A FOR PROFIT. AND THAT BEING THE CASE, WHERE DOES THE MONEY GO? WHO HAS JURISDICTION OVER IT? THE NONPROFIT OR THE FOR PROFIT? NOW WHEN YOU MULTIPLY THAT BY, I DON'T KNOW, THE 30 OR 40 DIFFERENT BUSINESS IMPROVEMENT DISTRICTS THAT OCCUR THROUGHOUT THE COUNTY OF LOS ANGELES AND THE FUNDING THAT INVOLVES THERE, LIKE TAKE FOR INSTANCE IN THE SOUTH PARK BUSINESS COMMUNITY IMPROVEMENT DISTRICT GOT $30 MILLION FROM THE STATE. BUT IF THEY HAVE A FOR PROFIT RUNNING THE NONPROFIT, YOU CAN BE SURE THAT THAT $30 MILLION ISN'T NECESSARILY GOING TO BE USED FOR ANYTHING THAT WOULD BENEFIT THE PUBLIC. SO MY INTEREST IN THIS POINT, AND I ADDRESSED THIS WHEN I SPOKE TO CITY COUNCIL, IS IN FACT THE FOR PROFIT ORGANIZATIONS THAT ARE HIRED BY THE NONPROFITS THE RUN THE NONPROFIT ORGANIZATIONS. IT DOESN'T MAKE ANY SENSE AT ALL. IT'S MISAPPROPRIATION OF FUNDING. IF YOU DID IT IN THE PRIVATE SECTOR, YOU'D BE ACCUSED OF -- WHAT'S THE WORD? I'M SORRY. IF YOU DID IT IN THE PRIVATE SECTION, YOU COULD BE PROSECUTED FOR MISAPPROPRIATION. THANK YOU FOR YOUR TIME, YOUR ANSWERS AND YOUR ATTENTION. 

SUP. BURKE, CHAIR: MOVED BY KNABE. SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. ITEM 15. 

ARNOLD SACHS: ITEM 15 HAS TO DEAL WITH A PAYMENT FOR MONEY THAT WILL BE USED FOR FREEWAY CONSTRUCTION IN THREE FLOOD CONTROL CHANNELS. THE REASON I BRING THIS ONE UP IS BECAUSE YEARS AGO WHEN THE 105 FREEWAY WAS BUILT, THERE WAS A PROBLEM WITH SOME AESTHETICS IN THE AREA THROUGH DOWNEY. AND THE PEOPLE WHO WERE GOING TO HAVE THE FREEWAY GO THROUGH THAT AREA COMPLAINED THAT THEY'D BE ABLE TO SEE THE ROADWAY. AND SO THE ENGINEERING THAT WAS WAS ACCOMPANYING THE CONSTRUCTION OF THE 105 FREEWAY ALLOWED FOR THE FREEWAY TO BE LOWERED INTO A FLOOD CONTROL CHANNEL, SO THAT EVERY TIME IT RAINS, THE ROAD GETS FLOODED. AND THERE IS A CONSTANT ALLOCATION. IT'S KIND OF LIKE THE GIFT THAT KEEPS ON GIVING WHERE PUMPS ARE REQUIRED 24 HOURS A DAY, 365 DAYS A YEAR TO MAINTAIN THE FREEWAY SO IT DOESN'T GET FLOODED BECAUSE IT'S IN A -- THEY LOWERED THE FREEWAY INTO THE FLOOD CONTROL CHANNEL. SO BUYING THIS PROPERTY THROUGH EMINENT DOMAIN OR GETTING THIS PROPERTY THROUGH EMINENT DOMAIN, I WOULD HOPE THAT WHEN THEY BUILD THIS ROADWAY, THAT THE ENGINEERS FROM CAL TRANS WOULD SAY "FLOOD CONTROL CHANNEL, DO WE WANT TO BUILD ANOTHER ROADWAY THROUGH THE FLOOD CONTROL CHANNEL"? I WOULD HOPE THEY WOULD LEARN FROM THE EXPERIENCE THAT OCCURRED FROM THE 105 FREEWAY AND MAYBE SOMEBODY WOULD SAY "I DON'T THINK THAT'S A GOOD IDEA." AGAIN, THANK YOU FOR YOUR TIME, YOUR ANSWERS AND YOUR ATTENTION. 

SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. ITEM 19. 

ARNOLD SACHS: ITEM 19 IS A BUDGET FOR SERVICES FOR BILLING. AND IT WAS BROUGHT UP EARLIER THAT THERE IS NO BUDGET FOR THE HEALTH SERVICES DEPARTMENT. AND PART OF THIS, I GUESS, IN A LITTLE BIT OF -- I'M TRYING TO TOUCH ON IS THE FACT THAT WHEN YOU WERE LOOKING OVER THE NUMBERS THAT IS WERE BROUGHT FORWARD BY THE HEALTH SERVICES AGENCY, AND THE FACT THAT THE FEES, THE COST OF CARE AT M.L.K. WAS ALMOST 2-1/2 TIMES ANY OF THE COSTS FOR THE OTHER FOUR COUNTY HOSPITALS, I BELIEVE THAT THE NEXT HIGHEST COST WAS ALMOST $400 PER PATIENT, I WAS WONDERING IF ANYBODY OR IF THERE'S BEEN ANY REVIEW AS TO DECIDE A, WHEN AND IF THE BUDGET FOR THE YEAR, FOR THE NEXT FISCAL YEAR IS APPROVED. BUT, B, WHY THE DIFFERENTIAL IN THE COSTS FOR M.L.K., THE PER PATIENT COST WAS ALMOST 2-1/2 TIMES WHAT IT IS FOR ANY OTHER OTHER HOSPITAL WHERE THE GROUPING IS, THERE'S A DISTINCT DIFFERENCE IN THE AMOUNTS. AGAIN, THANK YOU FOR YOUR TIME, YOUR ANSWERS AND YOUR ATTENTION. 

SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY MOLINA. WITHOUT OBJECTION, SO ORDERED. ITEM 36. 

ARNOLD SACHS: ITEM 36, VERY QUICKLY. AGAIN, DISABLED PERSONS MAKING IT A LITTLE EASIER, HAS THE COUNTY ET AL. EVER LOOKED INTO, AND AGAIN, I BROUGHT IT UP NUMEROUS TIMES, SIGNAGE THAT COULD BE IDENTIFIED BY BOTH THE DISABLED POPULATION AND THE SERVICE GROUPS THAT PROVIDE PICKUP AND TRANSPORTATION FOR DISABLED PERSONAGE, A SIGNAGE, MAYBE SOME KIND OF SIGNAGE, MAYBE EVEN A COMPETITION TO CREATE SIGNAGE THAT WOULD ALLOW FOR SPECIFIC DESIGNATED POINTS WHEN YOU HAVE A FACILITY THAT HAS MORE THAN ONE ENTRANCE OR EXIT, PEOPLE COULD BE DIRECTED TO GO TO THAT PARTICULAR SPOT WHERE THE SIGN OCCURS, WHERE THE SIGN IS LOCATED SO THAT THEY WOULD BE MORE EASILY SPOTTED BY THEIR PROVIDER. 

SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY MOLINA; WITHOUT OBJECTION, SO ORDERED. ITEM 44. 

ARNOLD SACHS: ITEM 44. 

SUP. BURKE, CHAIR: I'M SORRY. ITEM 37. 

ARNOLD SACHS: OH, ITEM 37 IS FUNDING FOR A -- 

SUP. BURKE, CHAIR: SEISMIC RETROFIT FOR A BRIDGE. 

ARNOLD SACHS: SEISMIC RETROFIT FOR A BRIDGE, THANK YOU VERY MUCH. JUST VERY QUICKLY. YEARS AGO, AND AGAIN, WHEN THE ALAMEDA CORRIDOR WAS PROPOSED AND THEN BUILT, IT WAS PROPOSED AND BUILT, IT WAS PROPOSED TO GO TO THE PORT OF LONG BEACH TO THE PORT OF L.A. AND IT NEVER QUITE MADE IT DOWN THERE. IT STOPPED A LITTLE BIT NORTH OF PACIFIC COAST HIGHWAY. AND THE CAL TRANS ALLOCATED $40 MILLION FOR A STUDY TO DECIDE WHAT WAS GOING TO HAPPEN WITH THE PIPES FROM THE OIL FACILITIES THAT ARE THERE. AND THAT ACTUALLY THE CORRIDOR WAS GOING TO EITHER GO OVER PACIFIC COAST HIGHWAY OR PACIFIC COAST HIGHWAY WAS GOING TO GO OVER THE CORRIDOR. NOTHING HAS EVER HAPPENED. $40 MILLION WAS SPENT. BUT NOTHING'S EVER HAPPENED. NO STUDIES WERE EVER PUT FORTH. I'M CURIOUS TO FIND OUT WHILE YOU'RE RETROFITTING THIS BRIDGE, COULD WE GO BACK AND BACKTRACK ON THE ALAMEDA CORRIDOR TO FIND OUT WHAT THE STATUS ON THAT PROJECT IS. 

SUP. BURKE, CHAIR: MOVED BY KNABE. SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. ITEM 44. 

ARNOLD SACHS: ITEM 44. SEVERAL YEARS AGO AGAIN, IN AN M.T.A. BOARD MEETING, IT WAS DISCUSSED WHETHER IT WOULD BE APPROPRIATE FOR LAW ENFORCEMENT PERSONNEL IN NEIGHBORING COMMUNITIES TO BE CONSIDERED -- TO HAVE THEM RIDE THE METRO SYSTEM IN UNIFORM AS AN ADDITIONAL SET OF EYES, EARS, WHATEVER, TO ASSIST THE SHERIFFS AND THE METRO POLICE IN SURVEILLANCE OR MAINTAINING SOME KIND OF PRESENCE ON THE TRANSPORTATION SYSTEM. THERE WAS DISCUSSION AT THE M.T.A. BOARD MEETING ABOUT THE ITEM. THERE WAS SOME PROBLEMS OR QUESTIONS BROUGHT UP ABOUT THE FACT WHETHER THESE PERSONNEL BEING IN UNIFORM WOULD BE CONSIDERED ON DUTY, WOULD IT AFFECT THEIR OVERTIME? WOULD IT AFFECT THEIR UNDER TIME? BUT THE ITEM EVIDENTLY WAS TABLED AND NEVER BROUGHT FORTH. AND NOW YOU'RE AGAIN APPROVING A BUDGET. SO I WAS WONDERING IF THIS ITEM, THIS PART OF THE PERSONNEL ISSUE COULD BE REVISITED, AND MAYBE THE QUESTIONS THAT HAD BEEN BROUGHT UP AT THE M.T.A. BOARD MIGHT HAVE BEEN LOOKED INTO, MIGHT HAVE BEEN ANSWERED. MAYBE IT CAN BE BROUGHT TO THE PUBLIC'S ATTENTION. AND MAYBE SOMETHING HOW THAT COULD BE INCLUDED IN THIS CONSIDERATION FOR THE SHERIFF'S BUDGET FOR SUPERVISION. 

SUP. BURKE, CHAIR: YOUR TIME HAS EXPIRED. MOVED BY ANTONOVICH. SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. 

ARNOLD SACHS: THANK YOU FOR YOUR TIME, YOUR ANSWERS AND YOUR ATTENTION. 

SUP. BURKE, CHAIR: SUPERVISOR MOLINA ON 23? 

SUP. MOLINA: I'M SURE THE DEPARTMENT IS GOING TO COME OUT AND CRY BABY TEARS ABOUT WHY IT NEEDS TO BE DONE, OTHERWISE NOBODY WILL DO IT. LET ME TAKE YOU BACK THREE YEARS ON THIS ITEM. THIS IS A SOLE-SOURCE CONTRACT WHERE THEY CAME TO US LAST MINUTE AND PUT TOGETHER THIS CORPORATION TO DO RADIOLOGY AT M.L.K. THEY WERE DESPERATE. I'M SURE MR. SCHUNHOFF DOESN'T EVEN REMEMBER THAT THREE YEARS AGO BECAUSE HE WASN'T THERE, BUT I WAS. I DIDN'T SUPPORT A SOLE SOURCE CONTRACT AT THAT TIME. I TOLD THEM THAT THEY HAD TO DO AN R.F.P. ON THIS. THAT THEY HAD HAD BILLING PROBLEMS IN THE PAST WITH THE SAME DOCTOR. AND THEY PROMISED THEY WOULD DO AN R.F.P. HERE WE ARE THREE YEARS LATER. THEY HAVEN'T DONE AN R.F.P. AND I'M SURE THEY HAVE 101 EXCUSES AS TO WHY IT HASN'T HAPPENED. THEY'RE ASKING US FOR ANOTHER EXTENSION ON THIS CONTRACT. AND THE WORST PART ABOUT IT, THEY'RE EVEN EXPANDING THE CONTRACT WITH THIS GUY. I THINK THIS IS SHAMEFUL, MR. SCHUNHOFF. IT GOES TO WHAT YOU TELL US HERE AND GO AND DO IN THE DEPARTMENT IS SOMETHING DIFFERENT. YOU HAVEN'T BEEN A PART OF IT THAT MUCH, BUT VERY FRANKLY I'M VERY TIRED OF THIS DEPARTMENT TELLING ME ONE THING AND DOING ANOTHER. AND IT ALMOST GOT PAST ME. BUT IT'S NOT. I DON'T THINK THAT WE SHOULD SUPPORT ANY EXTENSION WHATSOEVER. YOU HAD THE ABILITY AND YOU COME AT THE LAST MOMENT OF THE LAST DAY. I'M WAITING TO HEAR ALL OF YOUR LAME EXCUSES AS TO WHY YOU GOT HERE SO LATE, WHY YOU WAITED FOR IT TO GO SO LONG, WHY YOU SPENT THREE YEARS TRYING TO DO AN R.F.P. FOR SOMETHING YOU PROMISED ME THREE YEARS AGO. 

JOHN SCHUNHOFF: SUPERVISOR, IT'S MY UNDERSTANDING AT THAT THE R.F.P. CAN BE OUT WITHIN A MATTER OF A COUPLE OF WEEKS. 

SUP. MOLINA: OH, I'M SURE. IT COULD HAVE BEEN DONE A COUPLE OF WEEKS AGO, THREE YEARS AGO. 

JOHN SCHUNHOFF: I CAN'T SPEAK TO THE HISTORY OF THE PAST ON THIS. 

SUP. MOLINA: I UNDERSTAND, BUT I CAN. YOU DON'T DESERVE THIS CONTRACT. 

JOHN SCHUNHOFF: WE'RE IN A POSITION, THOUGH, WHERE IF THIS CONTRACT -- 

SUP. MOLINA: YOU ALWAYS ARE IN THIS POSITION BECAUSE YOU BRING IT TO US AT THE LAST MOMENT OF THE LAST DAY. YOU KNEW YOU WERE COMING UP AGAINST THIS EXTENSION. YOU NEW IT MONTHS AGO. 

JOHN SCHUNHOFF: WE DID. SUPERVISOR, WE'RE IN A POSITION, THOUGH, WHERE IF WE DON'T EXTEND THIS, I WON'T HAVE RADIOLOGY SERVICES. 

SUP. MOLINA: WHY ARE YOU EXPANDING IT? WHY DON'T YOU EXPAND IT FOR TWO WEEKS? 

JOHN SCHUNHOFF: I WOULD PROPOSE A MONTH, WHICH GIVES US A CHANCE TO -- 

SUP. MOLINA: I WOULD PROPOSE TWO WEEKS. 

SUP. YAROSLAVSKY: THAT'S UNREALISTIC. 

SUP. MOLINA: WELL, YOU KNOW, IT'S BEEN THREE YEARS. IT MAY NOT BE, BUT YOU KNOW, YOU GIVE THEM TWO WEEKS AND THEY'LL COME IN TWO WEEKS AND ASK FOR ANOTHER TWO WEEKS. THAT'S NORMAL FOR THEM. WHAT DOES IT TAKE TO GET AN R.F.P. OUT? THIS IS THREE YEARS. I GUESS MY CONCERN IS YOU EXPECT US NEVER TO NOTICE THIS THING. YOU JUST KIND OF COME IN HERE, THE DEPARTMENT CONTINUOUSLY LIES TO US. CONTINUOUSLY LIES TO US. I MEAN, THREE YEARS. WHY COULDN'T THEY HAVE GOTTEN THE R.F.P. DONE 2-1/2 YEARS AGO? BECAUSE WE GAVE THEM A THREE-YEAR EXTENSION. IF YOU GIVE THEM A ONE-MONTH EXTENSION THEY'RE GOING TO BRING IT IN THE LAST WEEK. I MEAN, WHAT COULD AN R.F.P. TAKE? IT'S NOT THAT COMPLICATED, JOHN. WHAT'S HOLDING IT UP? WHERE IS IT, DO YOU KNOW? 

JOHN SCHUNHOFF: THE STATEMENT OF WORK IS GOING TO COUNTY COUNSEL TODAY. IT'S BASICALLY AN R.F.Q. SO IN OTHER WORDS WE COULD SELECT MULTIPLE PROVIDERS OFF OF IT. SO IT CAN BE DONE FAIRLY QUICKLY. I'M TOLD THAT STAFF THINKS THAT THEY COULD GET IT COMPLETED WITHIN THREE MONTHS. MY REQUEST FOR A MONTH WAS SO WE COULD AT LEAST FIGURE OUT SOME ALTERNATIVE ANSWERS. 

SUP. MOLINA: GET IT COMPLETED. IS THAT HOW LONG IT'S GOING TO TAKE YOU, MR. FORTNER? IT'S GOING TO TAKE YOU A MONTH TO REVIEW THE LANGUAGE IN AN R.F.P.? 

RAY FORTNER: SUPERVISOR MOLINA, I DON'T BELIEVE IT WOULD TAKE US -- 

SUP. MOLINA: I DON'T UNDERSTAND WHY IT'S GOING TO TAKE THAT LONG, JOHN. 

RAY FORTNER: ANYTHING NEAR THAT LENGTH OF TIME TO REVIEW THE STATEMENT OF WORK IF THAT'S ALL WE'RE LOOKING AT THIS JUNCTURE. 

SUP. BURKE, CHAIR: R.F.Q., RIGHT? 

JOHN SCHUNHOFF: COUNTY COUNSEL WILL REVIEW IT VERY QUICKLY. THE ISSUE IS ONCE IT GETS OUT, IT HAS TO BE OUT ON THE STREETS FOR A WHILE AND THEN WE HAVE TO GET A BOARD LETTER BACK. THAT'S BASICALLY THE THREE MONTHS. 

SUP. MOLINA: I CAN ASSURE YOU THREE MONTHS WE'RE GOING TO SEE THIS FACE AGAIN ASKING FOR ANOTHER EXTENSION AND HAVING THE SAME EXCUSES. YOU DON'T DESERVE IT. 

SUP. BURKE, CHAIR: DO YOU WANT TO CONTINUE THIS FOR TWO WEEKS TO SEE IF THEY HAVE THE R.F.Q. OUT? 

SUP. MOLINA: SURE. 

SUP. BURKE, CHAIR: ALL RIGHT. WE'LL CONTINUE IT TO WHAT DATE WOULD THAT BE? 

CLERK SACHI HAMAI: THAT WOULD BE SEPTEMBER 2ND. 

JOHN SCHUNHOFF: IT WILL EXPIRE ON AUGUST 31ST. 

SUP. KNABE: IF YOU WANT TO TRY THE TWO WEEKS, WHATEVER YOU ARE GOING TO DO, YOU AT LEAST NEED TO HAVE THE RADIOLOGY SERVICES. BY CONTINUANCE, WHEN DOES THE CONTRACT EXPIRE? 

SHARON HARPER: I BELIEVE THE CONTRACT WOULD HAVE EXPIRED IF WE GO THE TWO WEEKS. SO THEY NEED SOME KIND OF INTERIM AUTHORIZATION. 

SUP. MOLINA: CAN I ASK A QUESTION? ABOUT HOW LONG IS THE BACKLOG ON RADIOLOGY UNDER THIS CONTRACT? 

JOHN SCHUNHOFF: I DON'T KNOW THE ANSWER. I CAN GET THAT FOR YOU. 

SUP. MOLINA: I BET YOU IT'S VERY LONG. THEY HAVE NEVER BEEN ABLE TO DO THEM ON TIME BEFORE. SO IT WON'T MEAN ANYTHING. 

SUP. BURKE, CHAIR: DO YOU WANT TO EXTEND THE CONTRACT FOR TWO WEEKS? 

SUP. MOLINA: IT MEANS SOMEBODY JUST DOESN'T GET PAID. IT DOESN'T MEAN THE WORK IS GOING TO GET DONE. I'M VERY SUSPICIOUS OF THIS CONTRACT. I WAS SUSPICIOUS. THIS STEMS FROM THAT CONTRACT THAT WE CAUGHT THEM AT, REMEMBER? THE 24/7 WHERE THEY HAD A RADIOLOGIST WORKING 24 HOURS A DAY 7 DAYS A WEEK. 

SUP. BURKE, CHAIR: IT WASN'T A RADIOLOGIST. THIS IS A DIFFERENT CONTRACT. 

SUP. MOLINA: I KNOW BECAUSE WE HAD TO FIRE THAT RADIOLOGIST. SO THIS DOCTOR, WHO IS STILL WORKING UNDER THE 24/7 CREATED A NEW CORPORATION. WE DIDN'T HAVE ENOUGH TIME TO DO AN R.F.P. AT THAT TIME, WHICH IS WHY WE DID THE SOLE SOURCE THREE YEARS AGO. WE WERE UNDER ALL OF THIS URGENCY OF READING ALL THESE X-RAYS. AND SO WHAT BOTHERS ME IS THAT THREE YEARS LATER THEY COME BACK IN THE LAST MINUTE OF THE LAST DAY. HOW PERFECT FOR THEM. 

SUP. BURKE, CHAIR: DO YOU WANT THE CONTINUE THE CONTRACT FOR TWO WEEKS AND CONTINUE THIS MATTER OVER? WHICH WOULD TAKE IT OVER TO SEPTEMBER 14TH AND CONTINUE THIS TO SEPTEMBER 2ND. AND BY THAT TIME FOR YOU TO HAVE THE R.F.Q. DO YOU WANT TO DO THAT, SUPERVISOR MOLINA? 

SUP. MOLINA: SURE. 

SUP. BURKE, CHAIR: SO THEN WITHOUT OBJECTION, THE CONTRACT WILL BE CONTINUED FOR TWO WEEKS OR TO SEPTEMBER 14TH. BUT ON SEPTEMBER 2ND YOU'RE GOING TO COME IN WITH THE R.F.Q. TO ASSURE THAT IT'S OUT. AND WITH AN ACCELERATED TIME TO GET A RESPONSE FROM IT. WITHOUT OBJECTION? MOVED BY MOLINA. SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. 

SUP. MOLINA: THANK YOU. 

SUP. BURKE, CHAIR: SUPERVISOR KNABE, YOU DID YOUR ADJOURNMENTS. THERE IS ONE ITEM SET FOR HEARING. BRING THAT UP? 54? 

SUP. KNABE: CALL IT UP? 

SUP. BURKE, CHAIR: DO YOU HAVE ANY OTHER ITEMS? 

SUP. KNABE: I DON'T HAVE ANY OTHER ITEMS. CALL 54. 

CLERK SACHI HAMAI: ON ITEM NO. 54, THIS IS THE PUBLIC HEARING. IF I COULD READ THE SHORT TITLE IN FOR THE RECORD. THIS IS HEARING ON ADOPTION OF THE 2008 CONGESTION MANAGEMENT PROGRAM LOCAL DEVELOPMENT REPORT AND SELF-CERTIFICATION RESOLUTION TO CONFORM WITH THE LOS ANGELES COUNTY CONGESTION MANAGEMENT PROGRAM. I ALSO NEED TO SWEAR IN ALL THOSE WHO PLAN TO TESTIFY BEFORE THE BOARD ON THIS ITEM. IF YOU COULD YOU PLEASE STAND AND RAISE YOUR RIGHT HAND? THERE WERE A COUPLE PEOPLE THAT WERE GOING TO TESTIFY ON THIS ITEM. 

SUP. BURKE, CHAIR: ONLY AS NEEDED. 

CLERK SACHI HAMAI: IN THE TESTIMONY YOU MAY GIVE BEFORE THIS BOARD, DO YOU SOLEMNLY AFFIRM TO TELL THE TRUTH, THE WHOLE AND NOTHING BUT THE TRUTH SO HELP YOU GOD? THANK YOU. YOU MAY BE SEATED. THERE IS NO DEPARTMENT STATEMENT ON THIS MATTER. 

SUP. BURKE, CHAIR: ALL RIGHT. ARE THERE ANY QUESTIONS? DO WE HAVE A MOTION? KNABE MOVES WE CLOSE THE PUBLIC HEARING. SECONDED BY ANTONOVICH. WITHOUT OBJECTION ON THE MOTION. MOVED BY KNABE, SECONDED BY MOLINA. WITHOUT OBJECTION, SO ORDERED. SUPERVISOR ANTONOVICH, FOR YOUR ADJOURNMENTS. 

SUP. ANTONOVICH: -- MUSEUM OF ART, ALONG WITH THE HUNTINGTON LIBRARY AND OTHER VENUES IN THIS COUNTY, HE WAS A NAVY DENTIST ON A MILITARY BASE IN CHINA DURING WORLD WAR II. HE WAS VERY COMMITTED TO HIS FAMILY AND COMMUNITY. HE WAS QUITE ACTIVE AND ENGAGED IN SAN MARINO. DR. JOAN HODGMAN, SHE PASSED AWAY AT THE AGE OF 84. SHE SPENT SIX YEARS AT COUNTY U.S.C. AS DIRECTOR OF NEWBORN DIVISION. PLAYED A CENTRAL ROLE IN DEVELOPING ITS INTENSIVE CARE FOR SICK AND PREMATURE BABIES, THE FIRST IN LOS ANGELES COUNTY, AMONG THE FIRST IN THE NATION. HER RESEARCH WITHIN 10 YEARS OF THAT, HER EFFORTS RESULTED IN A 50 PERCENT DECREASE IN THE INFANT MORTALITY RATE, WHICH AFFECTED THOUSANDS OF BABIES. SHE'S REMEMBERED AS A VERY INFLUENTIAL PROFESSOR, RESEARCHER, AND PRACTITIONER. JOE JORDAN, ARCHITECT FROM BURBANK WHO PASSED AWAY. HE WAS THE DESIGNER OF THE VAN NUYS SUPERIOR COURT ALONG WITH MANY LOS ANGELES COUNTY'S FIRE STATIONS, AND CITY OF ANAHEIM'S MAIN LIBRARY AND VALLEY VILLAGE IN SAN JOSE. HE ALSO BUILT ONE OF THE CHURCHES IN THE SAN FERNANDO VALLEY. HE WAS QUITE INVOLVED IN THE TOURNAMENT OF ROSES, WHERE HE DESIGNED A FLOAT THAT WON THE SWEEPSTAKES AWARD FOR THE CITY OF BURBANK. HE WAS THE PRESIDENT OF THE AMERICAN INSTITUTE OF ARCHITECTS, SAN FERNANDO VALLEY CHAPTER, AND 46-YEAR PERFECT ATTENDANCE AS A MEMBER OF THE BURBANK ROTARY CLUB. DR. MICHAEL LAU, A UROLOGIST, SURGEON, AND NAVY CAPTAIN. HE ATTENDED WASHINGTON AND LEE UNIVERSITY IN VIRGINIA, WAS A MEMBER OF GAMMA DELTA FRATERNITY AND GRADUATED IN 1941, FINISHING HIS MEDICAL SCHOOL AT YALE UNIVERSITY, THEN HE JOINED THE UNITED STATES NAVY AND HE SERVED ON THE U.S.S. COLUMBUS IN THE EAST AND AT THE PORT OF SHANGHAI AND HE SERVED IN THE SAIGON NAVAL HOSPITAL DURING VIETNAM. HE WAS A MEDICAL DOCTOR AT GOOD SAMARITAN HOSPITAL, ST. JOSEPH'S HOSPITAL, AND THE LOS ANGELES COUNTY HOSPITAL. MEMBER OF THE UNIVERSITY OF SOUTHERN CALIFORNIA MEDICAL FACILITY, AND ALSO HAD RETIRED AS A CAPTAIN IN THE NAVY. JAMES LUDLAM, ONE OF THE FOUNDERS OF OUR HEALTHCARE LAW, WHO SHAPED CALIFORNIA'S HEALTHCARE SYSTEM DURING THE 20TH CENTURY. STARTED HIS PRACTICE IN 1940 WHEN THERE WAS NO SPECIALIZATION IN HEALTHCARE LAW. HE WAS PROUD OF DOING PRO BONO WORK FOR HOSPITALS. AND HE ALSO, AS A DOCTOR, GRADUATED FROM THE HARVARD LAW SCHOOL IN 1939. AND HE WORKED TO STRENGTHEN THE TAX-EXEMPT STATUS OF NONPROFIT HOSPITALS. AND HE SPONSORED THE LANDMARK LEGISLATION THAT BROUGHT DOWN MALPRACTICE INSURANCE PREMIUMS, WHICH WAS THE LEGISLATION I HAPPENED TO BE A MEMBER OF THE LEGISLATURE AND ON THE SELECT COMMITTEE WITH CONGRESSMAN HOWARD BERMAN, WHO WAS THE CHAIRMAN AT THE TIME, WHICH HAS HELPED OUR DOCTORS STAY IN BUSINESS AND PROVIDE MEDICAL CARE TO OUR PEOPLE IN CALIFORNIA. HE PASSED AWAY AT THE AGE OF 87. AARON MARMON, ACTIVE IN THE ANTELOPE VALLEY, JOURNEYMAN CARPENTER, PASSED AWAY AT THE AGE OF 63. ENGINEER WILLIAM "BILL" STULLA. HE WAS KNOWN AS "ENGINEER BILL" IN "CARTOON" EXPRESS WHICH MANY OF US GREW UP WATCHING. CHILDREN'S CARTOON SHOW THAT AIRED FROM 1954 TO 1966 AS "ENGINEER BILL" TELLING YOU WHEN TO DRINK YOUR MILK, "RED LIGHT, GREEN LIGHT" AND A VERY INTERESTING INDIVIDUAL WHO WAS A GOOD MORAL LEADER FOR OUR YOUNG PEOPLE. 

SUP. KNABE: I'D LIKE TO JOIN IN THAT. 

SUP. ANTONOVICH: I HAD THE OPPORTUNITY OF MEETING HIM A FEW TIMES. HE KEPT HIS HUMOR AND GOOD ROLE MODEL FOR OUR YOUNG PEOPLE. DARREN "BO" TAYLOR, WHO PASSED AWAY AT THE AGE OF 42. HE WAS BORN IN TENNESSEE BUT HE MOVED TO LOS ANGELES WHEN HE WAS FIVE. HE WAS A FORMER MEMBER OF A GANG AND THEN BECAME A PEACE KEEPER. I HAD THE OPPORTUNITY OF WORKING WITH BO ON MANY OF OUR PROJECTS IN LOS ANGELES COUNTY, IN OUR COUNTY JAILS IN ALTADENA, IN THE SAN GABRIEL VALLEY. HE WAS ONE OF THE FIRST VOICES AND PERHAPS THE MOST INFLUENTIAL FROM THE INTERVENTION SIDE TO ADVOCATE COOPERATION WITH LAW ENFORCEMENT TO QUELL THE TIDE OF STREET KILLINGS. HE FORMED UNITY 1 TO TALK TO WARRING SETS OF GANG MEMBERS AND PERSUADE THEM TO LAY DOWN THEIR GUNS. HE WAS QUITE INVOLVED, HE WAS AT OUR BOARD MANY TIMES. HAD MANY OPPORTUNITIES TO WORK TOGETHER. ALSO WORKED WITH JIM BROWN. BUT IT WAS A BIG LOSS TO THE COMMUNITY. HE PASSED AWAY AT THE AGE OF 42 WITH CANCER. AND C. THOMAS WILCK, WHO WAS A PUBLIC AFFAIRS CONSULTANT FOR WALT DISNEY AND THE IRVINE COMPANY AND PREVIOUSLY HAD WORKED IN THE NIXON ADMINISTRATION, WHERE HE WAS ASSISTANT ADMINISTRATOR OF CONGRESSIONAL PUBLIC AFFAIRS FOR THE SMALL BUSINESS ADMINISTRATION. HE WAS A GRADUATE OF SANTA MONICA CITY COLLEGE, U.C.L.A., SERVED IN THE UNITED STATES MARINE CORPS. THEN IN 1971, PRESIDENT NIXON APPOINTED HIM AS THE ASSISTANT ADMINISTRATOR FOR THE SMALL BUSINESS ADMINISTRATION. HE PASSED AWAY AT THE AGE OF 75. AND I HAVE ONE MOTION. 

SUP. BURKE, CHAIR: SO ORDERED. 

SUP. ANTONOVICH: ON AUGUST 12TH THE BOARD HAD APPROVED THE EXTENSION OF REWARD OFFER FOR $10,000 LEADING FOR THE ARREST AND CONVICTION RESPONSIBLE FOR THE MURDER OF 16-YEAR-OLD SAMANTHA SALAS, WHO WAS FATALLY SHOT ON JANUARY 26TH IN MONROVIA. I'D LIKE TO ASK THAT THE BOARD INCREASE THAT TO $20,000 FOR ANY INFORMATION LEADING TO THE ARREST AND CONVICTION OF THAT PERSON OR PERSONS RESPONSIBLE FOR SAMANTHA'S KILLING. 

SUP. BURKE, CHAIR: SECONDED BY KNABE AND WITHOUT OBJECTION, SO ORDERED. 

SUP. ANTONOVICH: THAT'S ALL I HAVE. 

SUP. BURKE, CHAIR: IF THERE'S NOTHING FURTHER, THEN THE NEXT ITEM IS PUBLIC COMMENT. BLANCH CARIAS AND EMILY GALLEGOS. WOULD YOU PLEASE COME FORWARD? FOLLOWED BY EDWARD GUERRERO AND CARL POPULUS. BLANCH CARIAS? AND EMILY GALLEGOS, COME FORWARD? ARE YOU HERE? MAYBE I'M PRONOUNCING -- EDWARD GUERRERO AND CARL POPULUS, NICE TO SEE YOU. 

CARL POPULUS: NICE TO SEE YOU GUYS. THANK YOU FOR THIS OPPORTUNITY TO ALLOW ME TO SPEAK. VERY NICE PROGRAM YOU GUYS HAVE, VERY INTERESTING, ESPECIALLY ABOUT THE DRUGS. BUT WHY I'M HERE TODAY IS, LIKE I SAY, I'M SO BUSY TRYING TO BE BUSY IN THE FIELD I DON'T HAVE TIME TO COME DOWN AND SPEAK A LOT BUT I DO LOOK AT YOU GUYS ON TELEVISION. BUT I SAW SOMETHING LAST NIGHT THAT WAS VERY DISTURBING TO ME. I'M VERY DISTURBING. BECAUSE I SAW A SENIOR ON THE NEWS 85 YEARS OLD GET SLAMMED BY A PERSON AND ROBBED, PURSE TAKEN. THE GUY JUST WALKED AWAY. AND AS YOU KNOW, SOME OF YOU GUYS KNOW THAT I DEAL WITH, MY MAIN CONCERN IS CHILDREN AND SENIORS. 

SUP. BURKE, CHAIR: RIGHT. 

CARL POPULUS: AND THESE SENIORS, YOU KNOW, GRANDMOTHERS AND STUFF, MY GRANDMOTHER WAS 103 WHEN SHE PASSED AND MY MOTHER IS A SENIOR NOW AND HER SISTERS AND STUFF. SO I'M KIND OF CONCERNED ABOUT THAT. AND I'M JUST WONDERING, I KNOW WHEN I WALKED UP TODAY, YOU GUYS WAS HONORING THESE SENIOR GROUPS AND STUFF. BUT I KNOW FOR A FACT BY BEING OUT HERE ON THIS GROUND SUPPORT SYSTEM, THAT A LOT OF SENIORS NOW ARE LIVING IN FEAR. SOME OF THEM ARE LOSING THEIR HOMES BECAUSE THEY HAVE RELATIVES IN THERE SIGNING THOSE FALSE DOCUMENTS. AND THEY ARE JUST IN A LOT OF FEAR. SO I'M HERE TODAY REQUESTING HOPEFULLY THAT WE COULD GET TOGETHER SOMEBODY AND MAKE A BIGGER VOICE, A BIGGER ISSUE WITH THIS SENIOR ABUSE. AND EVEN SENIORS GETTING KILLED. SOME OF THESE SENIORS ARE LOSING THEIR HOMES. THEY DON'T HAVE RELATIVES TO GO TO. THEY'RE GOING TO THE STREET OR IN SOME NURSING HOME. SO I JUST WANT TO MAKE THAT APPEAL TODAY. BECAUSE IT'S GETTING WORSE AS WE STAND BY. SO I JUST HOPE THAT I COULD TALK TO SOME OF YOU GUYS AND WE COULD GET TOGETHER AND LOBBY THIS OR SOMETHING ABOUT THESE SENIORS BECAUSE IT'S REALLY BAD. THANK YOU VERY MUCH. 

SUP. BURKE, CHAIR: WELL CONSUMER AFFAIRS AS WELL AS YOU HEARD OUR DEPARTMENT, ANY TIME YOU HEAR OF SOMETHING LIKE THAT, BE SURE AND CONTACT, PARTICULARLY ELDER ABUSE WITH RELATIVES OR PEOPLE TAKING THEIR MONEY, CONTACT OUR CONSUMER AFFAIRS OR CONTACT OUR SENIOR DEPARTMENT. 

CARL POPULUS: I GUESS TO ENHANCE MY BOTTOM LINE IS, I WAS TRYING TO FIND OUT HOW COULD WE MAYBE GET TOGETHER AND DRAFT SOMETHING UP WITH STIFFER LAWS FOR THIS? BECAUSE APPARENTLY THE MESSAGE HASN'T BEEN GETTING OUT. BECAUSE SENIORS ARE STEADY BEING ABUSED AND TAKEN ADVANTAGE OF AND SOME OF THEM EVEN KILLED. SO I JUST I HOPE YOU GUYS THINK ABOUT THIS NOT JUST IN LOS ANGELES BUT EVERYWHERE, THAT SENIORS ARE BEING ABUSE. THANK YOU VERY MUCH. 

SUP. BURKE, CHAIR: THANK YOU. PLEASE STATE YOUR NAME. 

EDWARD GUERRERO: MY NAME IS EDWARD GUERRERO, BEFORE I GET STARTED, IF SOMEBODY OUT IN THE PUBLIC COULD PUT THIS ON YOUTUBE. MY DISABILITY DOESN'T AFFORD ME SUCH PRIVILEGES. AGAIN MY NAME IS EDWARD GUERRERO. I'M HERE TO SPEAK TO EACH AND EVERY ONE OF YOU INDIVIDUALLY, GLORIA MOLINA, DISTINGUISHED COUNCILMEMBER BURKE, YAROSLAVSKY, KNABE, MORE IMPORTANTLY, MIKE ANTONOVICH. FOR THE LAST FIVE YEARS, I HAVE COME HERE AND EXPLAINED AND EXPRESSED THE REPEATED POLICE BRUTALITY, HOSPITALIZATIONS AND MORE IMPORTANTLY, THE MALICIOUS PROSECUTION AND SEXUALLY MOLESTED BY A POLICE OFFICER, OFFICER HARDWICK FROM BURBANK. I WAS IN HANDCUFFS WHEN THE EVENT TOOK PLACE. I WAS BEING HELD BY A FEMALE OFFICER, AN OFFICER KAUFFMAN, THE THIRD OFFICER FELT THE NEED TO GRAB MY PRIVATE, NEARLY YANKED IT OFF. BUT MORE IMPORTANTLY, FOR THESE LAST FIVE YEARS, I HAVE CAME HERE, I SPOKE TO [INAUDIBLE] WHO IS A LIAR DEGENERATE. SHE SHOULD BE DEPORTED BACK TO HER COUNTRY. BECAUSE YOU GUYS KEEP TELLING ME THAT YOU HAVE NO AUTHORITY. NO AUTHORITY. AND YET YOU GUYS ARE THE COUNTY BOARD OF SUPERVISORS. AND YOU HAD ABSOLUTELY 100 PERCENT THE AUTHORITY TO GO TO DISTRICT ATTORNEY STEVE COOLEY. STEVE COOLEY, YOU AND THE REST OF YOU HAVE ALL ENGAGED IN AN ACT OF CONSPIRACY. I FORWARDED TO YOU DOCUMENTS, DECLARATIONS OF WITNESSES WHO WERE IN COURT WHO SAW A JURY, A JURY MEMBER GET BOOTED OFF THE JURY AND BECAME THE LEAD ATTORNEY ON THIS CASE. AND I WAS SENTENCED TO A YEAR IN COUNTY JAIL FOR CALLING A POLICE OFFICER A LIAR. SO WITH THAT, WITHOUT FURTHER ADO, I WANT YOU TO KNOW EACH AND EVERY ONE OF YOU, IT IS BECAUSE OF PEOPLE LIKE YOU THAT THIS COUNTRY HAS ENDURED SLAVERY, CORRUPTION, POLICE BRUTALITY, CHILD MOLESTATIONS. YOU GUYS ARE CRIMINALS. I COULD ONLY ASK GOD, I ASK DEAR LORD IN YOUR NAME I ASK RIGHT NOW ALL THESE PEOPLE MY WITNESS MAY HE PUT HIS HANDS ON YOU AND ALL THAT YOU LOVE. YOU GUYS LET ME DOWN. MIKE ANTONOVICH, I'D LIKE TO SOCK YOU IN THE STOMACH. YOU'RE A LIAR. YOU SHOOK MY HAND AND YOU TREATED ME LIKE "AH." BUT, SIR, YOU'RE A CRIMINAL. YOU HAD THE ABILITY, BURBANK IS YOUR CITY. YOU DID NOTHING. I'M STILL WAITING. I WAS SEXUALLY MOLESTED BY A COP. COPS ARE KILLING THEIR KIDS. COPS ARE KILLING INDIVIDUALS. COPS ARE RAPING AND MOLESTING THEIR OWN CHILDREN, MURDERING THEIR WIVES. AND YOU, ALL OF YOU, ALL OF YOU, IT WAS YOUR RESPONSIBILITY. YOU'VE DONE NOTHING. WHY DON'T YOU GUYS JUST QUIT? YOU GUYS ARE A BUNCH OF COWARDS. COWARDS. HAVE A NICE DAY. 

SUP. BURKE, CHAIR: THANK YOU VERY MUCH. HAROLD RAY AND MARISELA RODRIGUEZ? PLEASE COME FORWARD. HAROLD RAY, MARISELA RODRIGUEZ? BLANCH CARIAS? PLEASE STATE YOUR NAME. 

ANNA FAKTOROVICH: MY NAME IS ANNA FAKTOROVICH. THANK YOU SO MUCH FOR ACCEPTING THIS COMMENT. I ALSO HAVE A COMPLAINT, HOWEVER, MINE IS NOT QUITE AS VIOLENTLY CHARGED. I'M AFRAID THAT MY COMPLAINT IS COMING FROM SOMEBODY WITH A MASTERS' DEGREE AND SOMEBODY WHO IS ALSO VERY, VERY CONCERNED ABOUT THE CORRUPTION IN THIS CITY. SPECIFICALLY TODAY I WOULD LIKE TO SPEAK ABOUT UNFAIR RENTING PRACTICES IN LOS ANGELES. I LIVED AT 246 SOUTH KENMORE AVENUE IN LOS ANGELES. IT'S OWNED BY GLOBAL MANAGEMENT. AND THERE WAS GAS POISONING IN THAT APARTMENT. THERE WAS A LEAKING STOVE, A LEAKING HEATER, A LEAKING GAS PIPE. I SPENT QUITE A WHILE, ALMOST A MONTH, LIVING IN A FREEZING, VERY COLD APARTMENT WITHOUT A STOVE, WITHOUT A HEATER. SO IN DECEMBER. AND THE ELECTRICITY SOCKET GAVE ME AN ELECTRIC SHOCK ONCE AND WAS EMITTING PURPLE SPARKS. THE GAS POISONING WAS QUITE SEVERE AND IT LASTED FOR OVER A MONTH WITHOUT IT BEING FIXED. THE GAS OVEN WAS REMOVED BUT WAS NEVER REPLACED IN THE FOUR MONTHS THAT I SPENT THERE. ALL OF THESE CRIMES, I AM AFRAID, WERE GANG-RELATED HARASSMENT THAT WAS DELIBERATE. AND ALL OF THESE HARASSMENTS WERE NOT PREVENTED BUT IN FACT WERE ENCOURAGED BY THE LANDLORD. AT THAT TIME WHEN I MOVED OUT, THE LANDLORD SAID THAT I DIDN'T OWE HIM ANYTHING, AND IN FACT I NOTIFIED HIM IN ADVANCE BEFORE I LEFT. AND HE SAID THAT I COULD STAY. AND AFTER I NOTIFIED HIM HE ASKED ME TO STAY FOR ANOTHER 25 DAYS UNTIL FINALLY HE SAID THAT IT WAS TIME TO MOVE OUT. AND THEN QUITE A WHILE AGO, RECENTLY I RECEIVED A LETTER FROM DEBT COLLECTIONS AGENCY SAYING THAT I OWED THEM $1,400. AND THEN THE DEBT COLLECTOR CALLED ME AND WAS ABUSIVE OVER THE PHONE, WAS SCREAMING AT ME. AND I FEEL THAT I'M HERE TO ASK THE HOUSING AUTHORITIES OF LOS ANGELES COUNTY AND THE SUPERVISORS TO HELP ME PREVENT SIMILAR WRONGFUL HOUSING PRACTICES. AND ALL OF THE PEOPLE WHO ARE CONCERNED IN LOS ANGELES, THERE IS SOMETHING TO BE CONCERNED ABOUT. IF THERE IS A GAS POISONING FOUR MONTHS AND NOBODY CAN FIX POISONOUS POISONING INSIDE OF AN APARTMENT, AND IF I HAVE BROUGHT MY COMPLAINT I WAS A VICTIM OF BATTERY, OF ASSAULT, SEXUAL ASSAULT, ATTEMPTED RAPE AT GUN POINT AND ALL OF THESE ARE GANG-RELATED ASSAULTS. AND I JUST NEED SOME HELP. AND THERE HAS NEVER BEEN AN INVESTIGATION FROM ANY POLICE DEPARTMENT, AND I HAVE REPORTED THESE VARIOUS CRIMES TO THE LOS ANGELES, HOLLYWOOD, CENTRAL AND TO OTHER POLICE DEPARTMENTS, TO THE SHERIFF'S OFFICE. I FILED A NUMBER OF REPORTS. NOTHING. THERE HAS BEEN NO INVESTIGATION. SO THE DEAR PEOPLE OF LOS ANGELES, IF YOU ARE EVER A VICTIM OF GANG-RELATED VIOLENCE, APPARENTLY THE COUNTY WON'T DO ANYTHING. 

SUP. BURKE, CHAIR: SUPERVISOR ANTONOVICH IS YOUR SUPERVISOR. HE'LL SPEAK TO YOU. OF COURSE, YOU KNOW, L.A.P.D. IS THE CITY OF L.A. BUT IF YOU'LL GO RIGHT OVER THERE, SOMEONE FROM HIS OFFICE WILL HELP YOU. NORMA ZAMORA AND HILLARIE LEVY. AND THEN I'LL CALL ARNOLD SACHS. BUT EVERYONE WHOSE NAME I'VE CALLED, PLEASE COME FORWARD. MR. SACHS, WHY DON'T YOU START COMING FORWARD? SIR, WOULD YOU STATE YOUR NAME. 

ROB ROBBINS: MADAME SUPERVISOR, MY NAME IS ROB ROBBINS. I'M APPEARING IN THE PLACE OF BLANCA CARIAS. 

SUP. BURKE, CHAIR: ALL RIGHT. 

ROB ROBBINS: MY REASON FOR BEING HERE, I AM, SHE IS, WE ARE HOME CARE WORKERS WHO TAKE CARE OF PEOPLE ALL OVER THE COUNTY OF LOS ANGELES. WE HAVE PEOPLE HERE TODAY FROM LANCASTER CLEAR TO LONG BEACH. OUR REASON FOR BEING HERE: END OF JUNE OUR CONTRACT, WHICH IS SIGNED BY THE BOARD OF SUPERVISORS, ENDED. WE HAVE BEEN SITTING PATIENTLY AND PRODUCTIVELY WAITING FOR THESE TALKS TO RESUME. WE HAVE THOUSANDS OF PEOPLE WHO CALL US ON A REGULAR BASIS ASKING US WHAT'S GOING ON. WE ARE HERE TODAY TO ADDRESS THAT QUESTION TO THE SUPERVISORS. WHAT IS GOING ON WITH THE IN-HOME SUPPORTIVE CARE WORKERS' CONTRACT? WE ARE PATIENT. BUT BE IT RESOLVED THAT WE ARE ALSO DETERMINED. WE'VE COME QUIETLY AND PEACEFULLY HOPING THIS WILL EVOKE A POSITIVE RESPONSE. WE DON'T THINK IT'S NECESSARY TO BRING 35 BUS LOADS OF PEOPLE AND TIE UP THE CITY HERE. THAT IS NOT NECESSARY IN A DAY OF CHANGE. PLEASE TAKE US SERIOUSLY. SEND SOMEONE WHO IS GOING TO SIT DOWN AND TALK ABOUT THE ISSUES INTELLIGENTLY BEFORE WE FIND IT NECESSARY TO GET AMBULANCES AND BRING THE PEOPLE TO NURSING HOMES WHERE YOU WILL THEN PAY THE PRICE. THAT ISN'T NECESSARY. IT'S NOT WISE AND DECENT. HELP US HELP US TAKE CARE OF FOLK ONE-ON-ONE WITH LOVE AND WITH DIGNITY. WE AWAIT YOUR RESPONSE. I CLOSE BY SAYING WE AWAIT YOUR RESPONSE. 

SUP. BURKE, CHAIR: ALL RIGHT. WOULD THE C.E.O. LIKE TO MAKE A COMMENT? THANK YOU VERY MUCH. 

SHARON HARPER: YES, THANK YOU SUPERVISOR. JUST FOR A POINT OF CLARIFICATION, THE BOARD OF SUPERVISORS IS NOT THE EMPLOYER OF RECORD. WE DO NOT NEGOTIATE YOUR CONTRACT. YOUR CONTRACT AND YOUR BENEFITS ARE NEGOTIATED WITH THE PERSONAL ASSISTANT SERVICES COUNCIL. AND THAT'S WHERE YOU NEED TO DIRECT YOUR INQUIRIES. 

ROB ROBBINS: WHICH WE HAVE DONE. WE WENT TO NINE OF THEM AT 11 A.M. ON ONE DAY THEY TOLD US THE PROBLEM WAS HERE. WE WILL BE GOING BACK THERE. WE WILL BE GOING HERE. WE'LL BE GOING WHEREVER IS NECESSARY. BUT WE WILL GET THE JOB DONE. I HAVE SWORN FOR THE REST OF MY LIFE. MY WIFE DIED IN 2005. I WAS HER HOME CARE WORKER. I TOLD HER ON HER DEATH BED I WOULD DEDICATE THE REST OF MY LIFE TO HELPING PEOPLE WHO CAN'T HELP THEMSELVES. THAT'S WHY I'M HERE. WE STILL HAVE THE BLUEPRINT FROM TUSKEGEE, FROM DR. MARTIN LUTHER KING, FROM BYRON RUSTIN, ALL OF THOSE PEOPLE WHO HAVE BUILT THIS COUNTRY. I HOPE WE DON'T NEED TO BRING THAT OUT. LET'S NOT PASS THE BUCK. THE COUNTY SUPERVISORS WERE THE ONE WHO NAMED THESE PERSONAL ASSISTANTS, THEY ANSWER TO YOU. TELL THEM TO GO TO WORK. THANK YOU. 

SUP. BURKE, CHAIR: ALL RIGHT. PLEASE STATE YOUR NAME. 

HILLARIE LEVY: MY NAME IS HILLARIE LEVY. AT PAST MEETINGS, THE BOARD WAS INFORMED OF THE VIOLATION OF HIPAA AND CALIFORNIA HEALTH AND SAFETY CODE 11055 DURING WORK HOURS BY A SENIOR FIELD DEPUTY. THIS EMPLOYEE, WHO ALONG WITH HER FRIENDS, A THERAPIST AND PROBATE ATTORNEY, MANIPULATED A DYING SUBORDINATE INTO SIGNING CONTROL OF HER ALMOST $1 MILLION ESTATE TO THEM ALONG WITH TAKING POSSESSION OF THIS DYING EMPLOYEE'S MORPHINE. SHE ALSO SPENT OVER 23 OF HER WORK HOURS AT THE HOSPITAL AS THIS EMPLOYEE WAS DYING IDENTIFYING HERSELF AS AN EMPLOYEE OF THE SUPERVISOR AS SHE PRESENTED A NONLEGITIMATE MEDICAL DIRECTIVE TO THE HOSPITAL OMBUDSMAN WITH THE GOAL TO OBTAIN THE KEYS TO THE DYING EMPLOYEE'S CONDO IN AN ATTEMPT TO GAIN POSSESSION OF ITS CONTENTS. IN RETALIATION FOR THE SUBORDINATE'S FAMILY'S OBJECTING TO HER ACTIONS, SHE REFUSED TO ALLOW THE DECEASED EMPLOYEE'S BODY TO BE RELEASED FROM THE HOSPITAL MORGUE FOR 12 HOURS. I HAD SUGGESTED IMPLEMENTING CHANGES TO L.A. COUNTY CODE 6.09 INVOLVING IMPROVED MONITORING OF SALARIED EMPLOYEES IN RESPONSE TO THE COUNTY COUNSEL HUMAN RESOURCES AND AUDITOR-CONTROLLER'S DEFENSE OF THE SENIOR FIELD DEPUTY USING THE EXCUSE: THIS DOESN'T FALL UNDER THE SCOPE OF HER EMPLOYMENT. THE BOARD'S SHOCKING RESPONSE TO THIS GRIEVING MOTHER OF THE DECEASED EMPLOYEE WAS TO SEND A THREATENING AND INTIMIDATING LETTER BY AN ATTORNEY/LOBBYIST REGISTERED IN L.A. ON BEHALF OF THE SENIOR FIELD DEPUTY ALONG WITH BANNING HER FROM SPEAKING AT A BOARD MEETING FOR THREE MONTHS. ACCORDING TO THE D.A., THIS BOARD WAS INFORMED ON NOVEMBER 27TH, 2007, TO RESCIND THE THREE MONTH RULE AS THEY DETERMINED IT WAS AN INAPPROPRIATE BOARD RULE AS WELL AS A VIOLATION OF THE BROWN ACT. ACCORDING TO L.A. BOARD OF SUPERVISORS INFORMATION BOOKLET WHICH COVERS SECTION 39, PUBLIC COMMENT NONAGENDA ITEMS, THIS VIOLATION CONTINUES TO BE INCLUDED IN THE INFORMATION THE PUBLIC RECEIVES IN VIOLATION OF THE D.A.'S CORRECTIVE ACTION. NO ONE CAN BLAME THE SENIOR FIELD DEPUTY OR KING-DREW EMPLOYEES FOR BEHAVING AS IF THEY ARE ABOVE THE LAW, FOR THEY ARE SIMPLY FOLLOWING THE BOARD'S SAD EXAMPLE. EXISTING L.A. COUNTY AGENCIES HAVE PROVEN THEIR INEPTITUDE IN ADDRESSING DISTURBING EMPLOYEE BEHAVIOR AS WELL AS COMPLIANCE WITH LAWS AS DEMONSTRATED BY THIS AND THE KING-DREW INCIDENTS. FOR THE PROTECTION OF THE 10 MILLION COUNTY RESIDENTS, PLEASE CONSIDER AN L.A. COUNTY ETHICS COMMITTEE CONSISTING OF VOLUNTEER CITIZENS APPOINTED BY THE BOARD. THIS MUCH NEEDED COMMITTEE WOULD MORE EFFECTIVELY CURTAIL VIOLATIONS BY EMPLOYEES IN THE SUPERVISOR'S OFFICE AND ALL COUNTY ENTITIES AS WELL AS ENSURE COMPLIANCE WITH THE LAWS. NOT ONLY WOULD THIS ETHICS COMMITTEE IMPROVE THE COUNTY'S EFFICIENCY, THUS SAVING TAXPAYERS' MONEY, IT WOULD ALSO PROTECT THE SUPERVISORS' OFFICE FROM THE CONTINUING SHAME AND EMBARRASSMENT FROM HIGH PROFILE BLUNDERS. 

SUP. BURKE, CHAIR: THANK YOU VERY MUCH. PLEASE STATE YOUR NAME. 

MARISELA RODRIGUEZ: GOOD AFTERNOON. MY NAME IS MARISELA RODRIGUEZ, AND I AM HERE WITH MY MOTHER, NORMA ZAMORA. WE ARE HERE TODAY TO BRING TO MS. MOLINA'S ATTENTION THE DIFFICULTY WE ARE FACING WITH OUR FAMILY-OWNED RESTAURANT THAT WE HAVE IN EAST LOS ANGELES WHICH IS LOCATED ON 4771 EAST CESAR CHAVEZ. OUR BUSINESS WAS INITIALLY ESTABLISHED 20 YEARS AGO, AND THE FACILITY ITSELF HAS BEEN THERE FOR 30 YEARS. WE HAVE RECEIVED A LETTER FROM THE DEPARTMENT OF REGIONAL PLANNING INFORMING US THAT WE ARE IN VIOLATION BECAUSE OUR RESTAURANT HAS NOT BEEN APPROVED BY THEM. WE HAVE PROVIDED THEM WITH A COPY OF A PERMIT THAT HAS BEEN ISSUED BY THEM AND ALSO PERMITS FROM THE HEALTH DEPARTMENT AND THE COUNTY OF LOS ANGELES. OUR MAIN CONCERN AT THIS TIME IS THE REMOVAL OF SEVEN TABLES IN OUR RESTAURANT THAT PROVIDE SERVICE TO OUR CLIENTS. I BELIEVE THERE IS A MISUNDERSTANDING WITH THE TYPE OF BUSINESS THAT WE HAVE. OUR LOGO SAYS MEAT MARKET/RESTAURANT. AND THIS IS ONLY IN THE MEMORY OF MY GRANDFATHER, WHO ESTABLISHED HIS FIRST BUSINESS 45 YEARS AGO. IT WILL BE A BURDEN ON OUR FAMILY BUSINESS THAT HAS BEEN IN BUSINESS FOR SO MANY YEARS. THE REGIONAL PLANNING IS ASKING FOR THE REMOVAL OF THE TABLES BECAUSE THEY STATE WE HAVE NO PARKING FOR OUR CLIENTS. WE HAVE ALWAYS USED THE PARKING THAT WAS ESTABLISHED FOR ALL MERCHANTS AROUND OUR BUSINESS WITH NO PROBLEM. IT HAS BECOME A PROBLEM NOW SINCE THE REDEVELOPMENT DEPARTMENT SOLD THE PARKING ESTABLISHMENT TO THE DEVELOPER OF THE DENNY'S THAT IS IN CONSTRUCTION AT THIS TIME. IN THE PAST, THERE WAS ALSO STREET PARKING AND WAS REMOVED FOR THE NEW BUS STOP. WE WOULD LIKE TO ASK AT THIS TIME FOR OUR BUSINESS TO BE GRANTED GRANDFATHERED. THIS IS THE ONLY WAY THAT OUR BUSINESS WILL BE KEPT. WE HAVE NOTIFIED MISS MOLINA'S OFFICE WITH VERY UNDERSTANDING PEOPLE BUT THEY ARE NOT CONSIDERING ALL THE INFORMATION WE HAVE PROVIDED, INCLUDING COPIES OF OUR PERMITS. WE WOULD LIKE TO HAVE MISS MOLINA PERSONALLY REVIEW OUR PERMITS AND LICENSES THAT WE HAVE FOR OUR BUSINESS. WE DEPEND ON OUR BUSINESS TO SUPPORT OUR FAMILIES AS WELL AS OUR LONG-TERM EMPLOYEES. AS YOU MAY ALL KNOW HOW DIFFICULT IT IS TO HAVE AN EMPLOYMENT, A NEW EMPLOYMENT. WE HAVE STARTED A PETITION IN OUR COMMUNITY AND HAVE GATHERED OVER 100 SIGNATURES. PLEASE TAKE A MOMENT TO CONSIDER THIS PETITION. I SINCERELY THANK YOU FOR YOUR VALUABLE TIME. 

NORMA ZAMORA: I'M WITH HER ALSO. MY NAME IS NORMA ZAMORA. AND I WOULD ALSO LIKE TO, MISS MOLINA, TO TAKE AN OPPORTUNITY TO LOOK AT THIS PROJECT. AND WE WOULD LIKE TO CONTINUE TO DOING BUSINESS THERE IN EAST L.A. BASICALLY WE'RE JUST HERE HOPING YOU COULD SOLVE OUR PROBLEMS. 

SUP. MOLINA: HOW TO SOLVE YOUR PROBLEMS. I HAVE IT HERE. THE LETTER STATES VERY CLEARLY THAT YOU SHOULD START MEETING WITH MR. MADRIGAL AS WELL AS MR. MEDINA TO OUTLINE ALL OF THOSE ISSUES. THE PERMIT THAT YOU RECEIVED IS A HEALTH PERMIT. THAT DOESN'T NECESSARILY AUTHORIZE YOU BECAUSE YOU DON'T HAVE A ZONING PERMIT FOR THE RESTAURANT. YOU HAVE TO APPLY FOR THAT SO IT'S CONSIDERED NOT PERMITTED. JUST BECAUSE YOU HAVE A HEALTH PERMIT DOESN'T AUTHORIZE YOU TO OPERATE THE RESTAURANT, WHICH WILL LOOK AT ALL OF THE ISSUES ASSOCIATED WITH PARKING AND THINGS OF THAT SORT. WE'RE NOT TRYING TO STOP YOU FROM DOING BUSINESS, BUT PART OF OUR RESPONSIBILITY IS TO MAKE SURE THAT YOU FOLLOW THE RULES. I HAVE ALL OF IT HAS BEEN DETAILED EXTENSIVELY ALL THE WAY THROUGH. YOU STILL HAVE AN OPPORTUNITY TO ADDRESS THE UNPERMITTED MARKET ADDITION, WHICH IS THE QUESTION THAT WE'RE ASKING. JUST BECAUSE YOU'VE BEEN OPERATING IT FOR A NUMBER OF YEARS DOESN'T MAKE IT JUSTIFIED, IN A SENSE. AND SO CONSEQUENTLY WE'RE ASKING YOU TO WORK WITH MR. MEDINA OR MR. MADRIGAL. WE GAVE YOU THE PHONE NUMBER. THERE ARE PEOPLE OUT THERE FROM OUR ZONING AND OUR PUBLIC WORKS PEOPLE THAT CAN HELP YOU WITH REGARD TO CARRYING OUT YOUR BUSINESS. 

NORMA ZAMORA: THANKS. 

MARISELA RODRIGUEZ: SO THE ONLY REASON THAT I'M ACTUALLY HERE IS BECAUSE I HAD A PERMIT ISSUED FROM REGIONAL PLANNING AND THEY SAY SOMEBODY DID A MISTAKE ALONG THE WAY AND THEY'RE NOT MAKING IT EFFECTIVE. 

SUP. MOLINA: AGAIN, I'M NOT SURE. BUT I THINK THEY ARE REVIEWING THAT NOW. I MEAN IF IN FACT IT -- I DON'T KNOW WHAT MISTAKE YOU MADE, BUT YOU HAVE PLENTY OF OPPORTUNITY TO NEGOTIATE WITH THEM. YOU CAN BE EXTENDED. YOU CAN GET AN EXTENSION AS TO HOW TO MAKE THOSE CORRECTIONS. SO THERE SHOULDN'T BE A PROBLEM. I HAVE STAFF PEOPLE HERE THAT WILL HELP YOU WITH IT, BUT WE CAN'T GRANDFATHER THE NON-PERMITTED ASPECT OF IT. THERE IS NOT JUST ONE VIOLATION, IT'S A SERIES OF VIOLATIONS. SO WE CAN GO THROUGH THEM WITH YOU. WE CAN HAVE YOU SIT DOWN WITH THE ZONING FOLKS FROM THE VERY DAY THAT YOU CONTACTED US, WE'VE BEEN LOOKING AT THESE ISSUES. AND I CAN'T MAKE IT RIGHT FOR YOU. BUT COLLECTIVELY WE CAN DO SO. WE CAN GIVE YOU AN EXTENSION. BUT I THINK WE NEED TO LOOK AND REVIEW ALL OF THOSE PERMITS. SOMETIMES WHEN YOU LOOK AT SOMETHING, A PERMIT THAT MIGHT BE ISSUED DOESN'T MEAN THAT IT'S A PERMIT BECAUSE IT HASN'T GONE THROUGH THE PROCESS. SO NICOLE IS HERE. SHE'LL SIT DOWN AND HELP YOU WITH IT. 

MARISELA RODRIGUEZ: WE'LL TALK WITH HER. THANK YOU SO MUCH. 

SUP. MOLINA: THANK YOU. 

SUP. BURKE, CHAIR: MR. SACHS? 

ARNOLD SACHS: YES, GOOD AFTERNOON, ARNOLD SACHS. THANK YOU VERY MUCH. AT THE FINAL MEETING OF THE L.A. CITY COUNCIL BEFORE THEY TOOK THEIR TWO-WEEK AUGUST BREAK, I CONGRATULATED -- I MENTIONED MY CONGRATULATIONS FOR THE COUNTY BOARD OF SUPERVISORS AND THEIR ACTIONS IN PUTTING THE HALF CENT SALES TAX ON THE ROLL FOR NOVEMBER BALLOT. I MENTIONED ALSO THAT I WASN'T NECESSARILY SUPPORTING THE HALF CENT SALES TAX, ONLY THE FACT THAT THE COUNTY BOARD OF SUPERVISORS TOOK THE CORRECT STEP IN ALLOWING THE PUBLIC TO GET THE OPPORTUNITY TO DECIDE ON THE HALF CENT SALES TAX. BUT IN THE CONVERSATION THAT WAS BROUGHT UP BY SOME OF THE SUPERVISORS, THEIR REASONING TO NOT SUPPORT THE HALF CENT SALES TAX WAS BASED ON THE FACT THAT OH, MAYBE THE FUNDING WASN'T GOING TO BE ALLOCATED PROPERLY. THERE WAS SOME BACKROOM NEGOTIATIONS, DEALS, THINGS OF THAT NATURE. AND IN EXPLAINING THIS TO THE CITY COUNCIL, I TRIED TO DUMB DOWN SOME LESSONS TO THEIR LEVEL. AND I BROUGHT UP TO THEM THE IDEA OF WEST HOLLYWOOD, HOLLYWOOD, NORTH HOLLYWOOD, ESPECIALLY REGARDING SOME OF THESE NUMEROUS NAMES FOR THESE PROJECTS COMING ALONG. AND ONE OF MY FAVORITES AS LATELY HAS BEEN THE MID CITY, EXCUSE ME. THE EXPO, THE METRO LINE CONSTRUCTION OR THE LIGHT RAIL TRANSIT PROJECT WHERE IT HAS GONE AS A COOPERATIVE AGREEMENT BETWEEN THE CITY OF LOS ANGELES ACTING THROUGH ITS DEPARTMENT OF WATER AND POWER AND THE EXPOSITION METRO LINE CONSTRUCTION AUTHORITY. OR THE FINANCIAL CONTRIBUTION AGREEMENT BETWEEN THE CITY OF LOS ANGELES AND THE LOS ANGELES METROPOLITAN AND TRANSPORTATION AUTHORITY FOR PHASE 1 OF THE METRO EXPOSITION LIGHT RAIL TRANSIT PROJECT. THE PROJECT DEFINED IN THIS ITEM, THOSE ACTIVITIES THAT ARE NECESSARY TO MEET THE OBJECTIVE OF CONSTRUCTING AND PLACING REVENUE OPERATION A LIGHT RAIL TRANSIT LINE KNOWN AS THE METRO EXPOSITION LIGHT RAIL TRANSIT LINE. PHASE 1, FUNDING PLANS. L.A.C.M.T.A. EXPOSITION LIGHT RAIL TRANSIT PROJECT. THEN ALONG COMES THIS ITEM IN APRIL 4TH OF 2008 FOR THE MID-CITY EXPOSITION LIGHT RAIL TRANSIT PROJECT FROM THE CHIEF LEGISLATIVE ANALYST JERRY F. MILLER FROM THE CITY COUNCIL. THE CITY OF LOS ANGELES IS GOING TO ALLOCATE $35 MILLION FOR THE MID-CITY EXPOSITION LIGHT RAIL TRANSIT PROJECT. THE QUESTION BEING, YOU HAVE QUESTIONS REGARDING ALLOCATION OF FUNDING. THE PROJECT STARTS OUT AS THE EXPOSITION LIGHT RAIL TRANSIT PROJECT. 

SUP. BURKE, CHAIR: THANK YOU. YOUR TIME IS EXPIRED. 

ARNOLD SACHS: YOU'RE GOING TO ACCEPT THE FACT THAT IT IS NOW CHANGED TO THE MID CITY. 

SUP. BURKE, CHAIR: THANK YOU. 

ARNOLD SACHS: THANK YOU. AND AGAIN THANK YOU FOR YOUR ANSWERS AND YOUR TIME AND YOUR ATTENTION. 

SUP. BURKE, CHAIR: YOU'RE QUITE WELCOME. IS THERE ANYTHING FURTHER TO COME BEFORE US? 

CLERK SACHI HAMAI: I JUST HAVE A BRIEF ANNOUNCEMENT THAT THE NEXT REGULAR MEETING OF THE BOARD OF SUPERVISORS WILL BE SEPTEMBER 2ND AT 1 O'CLOCK P.M. 

SUP. BURKE, CHAIR: THE MEETING IS ADJOURNED. 
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